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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems. This guide describes instructions on how to set up 
the printer drivers required for this equipment, and how to print with them. Read this manual before using your 
Multifunctional Digital Systems. Keep this manual within easy reach, and use it to configure an environment that makes 
best use of the e-STUDIO’s functions.

How to read this manual

Symbols in this manual
In this manual, some important items are described with the symbols shown below. Be sure to read these items before 
using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 
the following signage:

Screens
Screens on this manual may differ from the actual ones depending on how the equipment is used, such as the status 
of the installed options.
The illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the 
display or the order of buttons in the illustrations may differ from that of your equipment.

Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are 
trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, TrueType, and LaserWriter are trademarks of Apple Inc. in the US 
and other countries.
Adobe, Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader, and PostScript are trademarks of Adobe Systems 
Incorporated.
Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and 
other countries.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respective companies.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.





CONTENTS    3

CONTENTS

Preface....................................................................................................................................... 1

Chapter 1 OVERVIEW

Features and Functions ........................................................................................................... 6

About Printer Drivers ............................................................................................................... 7
For Macintosh........................................................................................................................ 7
For UNIX/Linux...................................................................................................................... 7

Chapter 2 PRINTING FROM WINDOWS

Before Using the Printer Driver............................................................................................. 10
Configuring the options........................................................................................................ 10
Setting the department code ............................................................................................... 12
Copying the PPD file for Windows....................................................................................... 14

Printing from an Application ................................................................................................. 15
Considerations and limitations............................................................................................. 15
How to print ......................................................................................................................... 16

Setting Up Print Options........................................................................................................ 18
How to set up ...................................................................................................................... 18
Print options ........................................................................................................................ 21

Printing with the Best Functions for Your Needs................................................................ 55
Printing various print job types ............................................................................................ 55
Layout and finishing options in the [Basic] tab menu .......................................................... 62
Layout and finishing options in [Finishing] tab menu........................................................... 63
Finishing options in the [Paper Handling] tab menu............................................................ 70
Finishing options in the [Effect] tab menu............................................................................ 72
Using various types of paper ............................................................................................... 76

Chapter 3 PRINTING FROM MACINTOSH

Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.5.x .............................. 80
Considerations and limitations............................................................................................. 80
How to print from Mac OS X 10.2.4 to Mac OS X 10.5.x..................................................... 81
Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.5.x.............................................. 83
Print dialog on Mac OS X 10.3.x to Mac OS X 10.5.x ......................................................... 88
Print dialog on Mac OS X 10.2.x ....................................................................................... 102

Chapter 4 PRINTING FROM UNIX/Linux

Printing from an Application ............................................................................................... 114
Considerations and limitations........................................................................................... 114
Printing using lp command ................................................................................................ 114
Generic “lp” and “lptap” options......................................................................................... 114
General options ................................................................................................................. 115
PCL5e Specific Options..................................................................................................... 123

Chapter 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL

Monitoring the Print Job Status .......................................................................................... 128
Normal Print/Scheduled Print jobs..................................................................................... 128



4    CONTENTS

Proof Print jobs.................................................................................................................. 132
Private Print jobs ............................................................................................................... 135
Hold Print jobs ................................................................................................................... 139
Invalid jobs ........................................................................................................................ 143
Printing files from USB media (USB Direct Printing) ......................................................... 146

Viewing the Print Job Log ................................................................................................... 151

Chapter 6 OTHER PRINTING METHODS

FTP Printing .......................................................................................................................... 154

Email Printing ....................................................................................................................... 155

Chapter 7 APPENDIX

Internal Fonts List ................................................................................................................ 158
Internal PCL fonts list ........................................................................................................ 158
Internal PS fonts list........................................................................................................... 159

INDEX ................................................................................................................................................................... 161



1.OVERVIEW

This chapter gives an overview of the printing functions.

Features and Functions........................................................................................................... 6
About Printer Drivers............................................................................................................... 7

For Macintosh.........................................................................................................................................................7
For UNIX/Linux.......................................................................................................................................................7



1 OVERVIEW

6    Features and Functions

Features and Functions

Extensive Client Platform Support
This equipment supports printing from IBM-compatible PC, Macintosh, and UNIX/Linux workstations. Not all features are 
supported on all platforms, however.

Various Port Options
You can map this equipment to print to an SMB, IPP, Raw TCP, or LPR port.

Multiple Job Types
Job Types refer to the way this equipment handles a print job.

Normal mode requires no special handling and is the most frequently used printing mode.
Scheduled Print lets you specify the time and date at which to print a job.
Private Print mode allows you to hold a job in the print queue until you enter a password at the touch panel to print the 
job.
Hold Print mode allows you to hold a job in the hold queue until you continue the job from the touch panel.
Proof Print mode prints the first copy of a multi-copy job and then awaits your approval before printing the remaining 
copies.
Overlay File prints a document element, such as text or graphics, to a file for superimposing on the background of 
other documents.
Store to e-Filing mode allows you to store the printed document in e-Filing.

Professional Finishing Options
Depending on the type of finishing units you have installed on this equipment, you can choose to sort, group, fold, staple 
your documents (including saddle-stitching) and punch binding holes.

Sophisticated Document Layout and Assembly Options
You can choose whether to print your document as you have set it up in the application, or to impose printer-driven 
document layout options such as printing in Book Format or printing Multiple Pages per Sheet.
Additionally, the printer drivers provide the ability to print selected pages on different media. This includes printing front 
and back covers, inserting sheets at predefined positions within the document, or interleaving pages so that every other 
page is inserted blank or printed on a different type of media.

Various Sizes of Printing Paper Available
You can use paper larger than the standard sizes defined in the custom paper size setting when you print data created 
with applications. (Largest size: 11.70 x 17 inches (297 x 432 mm))

Watermark and Image Overlay Support
Watermarks are a great way to subtly convey useful information about your printed documents. Common watermarks are 
[Confidential], [Draft] and [Original]. Several watermarks have been pre-defined for use with your documents, or you can 
create and save your own custom watermarks.
Watermarks consist of text. Image Overlays can be any combination of text, graphics or other document elements.
Printing watermarks consumes fewer resources than using Image Overlays, so you should use watermarks wherever 
possible, particularly when printing speed is an issue.

This equipment provides the printing function as an option. However, this optional printing function is already installed 
in some models.
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About Printer Drivers

Printer drivers required for each OS are included in the Client Utilities CD-ROM. For instructions on how to install them, 
refer to the Software Installation Guide.

For Macintosh
The printer driver required for Macintosh OSs is included in the following folder of the Client Utilities CD-ROM:

Macintosh PPD files
[Client Utilities CD-ROM]:MacPPD:OSX
This includes the PPD file to enable printing from Macintosh on the Mac OS X 10.2.4 to Mac OS X 10.5.x.

For UNIX/Linux
The printer drivers required for UNIX/Linux are included in the following folders of the Client Utilities CD-ROM:

Solaris Filter
[Client Utilities CD-ROM]/Admin/SolarisFilter/Usa/
This includes the tar file for Solaris v2.6/2.7/7.8/8/9.

HP-UX Filter/HP-UX64 Filter
[Client Utilities CD-ROM]/Admin/HP-UXFilter/Usa/
This includes the tar file for HP-UX ver.10.20/11.x and the one for HP-UX64 ver.11.31.

AIX Filter
[Client Utilities CD-ROM]/Admin/AIXFilter/Usa/
This includes the tar file for AIX 4.3.3.

Linux Filter
[Client Utilities CD-ROM]/Admin/LinuxFilter/Usa/
This includes the tar file for Red Hat 7.x/8.x/9.x, Red Hat Enterprise WS2, SuSE Linux 7.x/8.x/9.x, Mandrake Linux 7.x/
8.x/9.x and Turbolinux 8/10.

SCO UNIX Filter
[Client Utilities CD-ROM]/Admin/OpenUnixFilter/Usa/
This includes the tar file for SCO UnixWare 7 and SCO Open UNIX 8.

CUPS PPD files
[Client Utilities CD-ROM]/Admin/CUPS/Usa/
This inludes the PPD file to enable printing from CUPS.
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Before Using the Printer Driver

Before printing, you have to configure the following option:
Configuration Settings
To use optional devices such as optional drawers, Finisher or Hole Punch Unit, you must first configure these devices. 
The features of these optional devices are not available unless you tell the system that the optional devices are 
installed.

Before printing, you can configure the following option if necessary:
Department Code
You can use department codes to manage each job. For example, a system administrator can check how many sheets 
of copies a certain department has made. When the Department code is enabled, you are prompted to enter a 
department code before printing. If you enter the department code in the corresponding field in advance, you can print 
without having to do this every time. Ask your administrator about the codes. When SNMP communication between 
the equipment and your computer is enabled, you are also prompted to enter the code before printing.

Configuring the options
To use this equipment properly, you need to save the configuration of the options installed on the [Configuration] tab menu 
after you install the printer drivers. In the default setting, you can obtain the configuration data of options installed 
automatically by opening the [Configuration] tab menu. If SNMP communication between this equipment and your 
computer is not available, or you want to configure options manually, see the following page:

 P.10 “Configuring options manually”

If available, select [Manual] of [Enable SNMP Communication] check box on the [Configuration] tab menu, and 
then click [Update Now]. You can obtain the configuration data as you click it. 

All the screenshots in this chapter are examples from Windows Vista.

Configuring options manually
If SNMP communication between this equipment and your computer is not available, configure the options manually.

Setting the [Configuration] tab manually

You need to log into Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” privilege (for 
Windows 2000/XP/Vista/Server 2003/Server 2008).

1 Click the [Start] menu, [Control Panel], [Hardware and Sound] and select [Printer].
The Printers folder appears.

For Windows XP or Windows Server 2003
Click the [Start] menu and select [Printers and Faxes].
For Windows 2000
Click the [Start] menu, [Settings] and select [Printers].
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2 PRINTING FROM WINDOWS

2 Select the printer driver for this equipment, and click the [File] menu, [Run as 
administrator] and select [Properties]. Enter the administrator password if required.

If the [File] menu is not displayed, press [Alt].
The [User Account Control] dialog box appears.
The printer driver properties dialog box appears if the User Account Control setting is disabled. Go to step 4.

3 Click [Continue] in the [User Account Control] dialog box.
The printer driver properties dialog box appears.

4 Display the [Configuration] tab menu, and set the following options.

Model Selection — This option sets the model type of the equipment.
Option — This option sets whether the following optional devices are installed.

Drawers — This option sets whether the drawers or Large Capacity Feeder (optional) are installed.
Finisher — This option sets whether or not the Finisher (optional) is installed.
Hole Punch Unit — This option sets whether or not the Hole Punch Unit (optional) is installed.

The Large Capacity Feeder (optional) is not available for some countries or regions.

For more information about each item, see the descriptions about the [Configuration] tab.
 P.51 “[Configuration] tab”

5 Click [Drawer Settings].
The [Drawer Settings] dialog box appears.
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6 Set the following options and click [OK].

Drawer 1 — Select the size and type of paper that is loaded in the 1st Drawer.
Drawer 2 — Select the size and type of paper that is loaded in the 2nd Drawer.
Drawer 3 — Select the size and type of paper that is loaded in the 3rd Drawer (optional) when it is installed.
Drawer 4 — Select the size and type of paper that is loaded in the 4th Drawer (optional) when it is installed.
LCF — Select the size and type of paper that is loaded in the Large Capacity Feeder (optional) when it is installed.
Bypass Tray — Select the type of paper that is loaded in the Bypass Tray.
Override Application Paper Source Settings — Select this check box to use the paper source setting in the 
printer driver rather than the application setting.

The Large Capacity Feeder (optional) is not available for some countries or regions.

For more information about each item, see the descriptions of Drawer Settings.
 P.53 “Drawer Settings”

7 Click [Apply] and [OK] to save settings.

Setting the department code
When this equipment is managed with department codes, you have to enter your department code on the printer driver.
This feature allows a network administrator to check the number of copies printed by a specific department. Also users 
can check who submitted the print jobs, by touch panel display and monitoring tools.
Ask your administrator whether you should enter the Department Code.

When the User Management Setting is enabled on the equipment, the User Management Setting is used to manage 
the print jobs instead of the department code. In that case, the user name that is entered to log in to your computer is 
used for the authentication of the print job. Therefore, you do not need to enter the department code in the printer 
driver but your user name must be registered in the equipment. If the user name is not registered, your print job is 
processed as an invalid job according to the Department Code Enforcement settings.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Department Code Enforcement setting that can be set in the TopAccess 
Administrator mode and whether SNMP communication is enabled or not. When SNMP communication is enabled 
and Department Code Enforcement is set to [ON], an error message will be displayed when entering an invalid 
department code. When SNMP communication is disabled and Department Code Enforcement is set to [ON], the 
invalid department code print job will be stored in the invalid department code print job list without printing. When 
the Department Code Enforcement is set to [Print], the invalid department code print job will be printed. When the 
Department Code Enforcement is set to [Delete], the invalid department code print job will be deleted without 
printing.
A department code needs to be entered every time you begin printing. If you have to use a different department 
code for each print job, enter it when you begin printing.
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Entering department code

1 Click the [Start] menu, [Control Panel], [Hardware and Sound] and select [Printer].
The Printers folder appears.

For Windows XP or Windows Server 2003
Click the [Start] menu and select [Printers and Faxes].
For Windows 2000
Click the [Start] menu, [Settings] and select [Printers].

2 Select the printer driver of this equipment, and then click the [File] menu and select 
[Printing Preferences].

If the [File] menu is not displayed, press [Alt].
The printing preferences dialog box appears.

3 Select the [Others] tab menu and enter your department code in the [Department] box.

In the [Department] box, only numeric characters can be entered. The Department Code must be a 5-digit number. 
If the department code is shorter than 5 digits, add 0 to make it 5 digits long.

4 Click [Apply] and [OK] to save the settings.
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Copying the PPD file for Windows
The Client Utilities CD-ROM contains a printer description file for popular Windows applications. For applications not 
allowing the automatic installation of PPD files, copy the PPD file to a proper directory in order to enable printer-specific 
settings in the [Print] dialog box or the [Page Setup] dialog box.

Copying the printer description file

1 In the Client Utilities CD-ROM, open the folder that contains the PS3 printer driver.
For Windows 2000/XP/Vista/Server 2003/Server 2008:
[Client Utilities CD-ROM]:\Client\Drivers\PS\W2K_XP_VISTA\<language>\
For Windows XP x64/Vista x64/Server 2003 x64/Server 2008 x64:
[Client Utilities CD-ROM]:\Client\Drivers\PS\XP_VISTA_X64\<language>\

2 Copy the printer description file (*.ppd) to the appropriate location.

For a proper directory to which the PPD file is to be copied, refer to the manual of the application.
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Printing from an Application

This section describes how to print a document from an application.
 P.15 “Considerations and limitations”
 P.16 “How to print”

Considerations and limitations
When the User Management Setting is enabled on the equipment, the user name that is entered to log in to your 
computer is used for the authentication of the print job. Therefore, your user name must be registered in the 
equipment. If the user name is not registered, your print job is processed as an invalid job according to the Department 
Code Enforcement settings.
When the Windows Domain Authentication is used for the User Management Setting, your computer must log into the 
domain.
Some print options can be set from both the application and the printer driver, such as collation. If the collation is set 
from the application, documents may not be properly printed. If that happens, use the printer driver to set the collation. 
Depending on the application, some print options such as the orientation need to be set from the application. For print 
options that can be set from both the application and the driver, refer to the manual of the application.

About “Use PostScript Passthrough”
When printing with the PS3 printer driver from Adobe Acrobat, the Fit to Paper enlargement feature does not work if 
the [Use PostScript Passthrough] option is enabled in the PostScript settings of the PS3 printer driver. To use the Fit to 
Paper enlargement feature, disable the [Use PostScript Passthrough] option in the PostScript settings of the PS3 
printer driver.
When printing with the PS3 printer driver from an application that creates the PostScript code for printing such as 
Adobe Acrobat, the following print options may not work correctly. In that case, disable the [Use PostScript 
Passthrough] option in the PostScript settings of the PS3 printer driver.
- Manual Scale
- Print Paper Size
- Paper Type
- Use Front Cover
- Use Back Cover
- Interleave Pages
- Insert Pages
- Booklet
- Multiple Pages per Sheet
- All options in the [Effect] tab
- All options in the [Image Quality] tab
- Margin
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How to print
Once you have installed the printer driver and configured it properly, you can print directly from most Windows 
applications. Simply choose the Print command from your application.
You can print using the various functions by setting print options on the printer driver.

Printing from Windows applications

The following describes an example for printing from Notepad on Windows Vista.

1 Open a file and select [Print] from the [File] menu of the application.
The [Print] dialog box appears.

2 Select the printer driver of the equipment to be used and click [Preferences].

The [Printing Preferences] dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different depending on the 
application that you are using. See your application’s manual about displaying the printer properties dialog box.

3 Set the print options on each tab according to how you want to print.

Setting the print options varies depending on how you want to print a document.
 P.21 “Print options”

You can also set the print options using profiles.
 P.18 “Setting print options using profiles”

4 Click [OK] to save the settings.
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5 Click [Print] to print a document.
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Setting Up Print Options

Print Options are the attributes you set to define the way a print job is processed. For example, the private print and proof 
print options determine how the copier manages your print job.

To find the printing instructions for your specific needs, see the procedures in the following section.
 P.55 “Printing with the Best Functions for Your Needs”

How to set up
There are several ways to set print options. How the settings affect printing varies depending on the way you set the 
options. The tabs displayed also vary depending on how you display the printer properties.

Setting initial values of print options
Setting the print options by displaying the printer properties from the Printers folder within the Windows Start menu will 
establish the initial values of the options. For example, the paper size setting you most commonly use, optional device 
settings, user information settings, etc., are settings you will not want to change every time you print. It is convenient to set 
these options as initial values.

How to display: Windows Vista/Server 2008

1 Click the [Start] menu, [Control Panel], [Hardware and Sound] and select [Printer].

2 Select the printer driver for the equipment, click the [File] menu and select [Printing 
Preferences].
If the [File] menu is not displayed, press [Alt].

How to display: Windows 2000/XP/Server 2003

1 Click the [Start] menu and select [Printers and Faxes] (Select [Settings] and [Printers] 
for Windows 2000).

2 Select the printer driver for the equipment, click the [File] menu and select [Printing 
Preferences].

Setting print options for each print job
The print options that are set in properties dialog box, which can be accessed from the [Print] dialog box of the application, 
are only applied to the current print job, so once you close it, the options will be invalid.

How to display:

1 Click the [File] menu and select [Print] in the application.

2 Select the printer driver of the equipment to be used and click [Properties].

Setting print options using profiles
Using profiles, you can save the print settings or apply the saved settings to a print job.

There are 4 factory default profiles as follows:
- Duplex, Staple & 2in1
- Booklet
- Duplex & Staple
- Duplex, Staple & Punch
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In order to print a document using profiles, you must first create the saved profile.
 P.19 “Saving profiles”

Once you save a profile, you can apply its settings to a print job.
 P.20 “Loading profile”

You can also delete unnecessary profiles.
 P.20 “Deleting profile”

Saving profiles

You can register up to 20 profiles (including 4 default profiles) for each printer driver.

You can delete the default profile or overwrite it after changing its contents and saving it under the same name.

1 Configure the print options on each tab.
Setting the print options varies depending on how you want to print a document.

 P.21 “Print options”

2 Click [Save Profile] in the Profile group.

The [Profile Name] dialog box appears.

3 Enter the profile name and click [OK].

The file name can be up to 63 characters long.

If you enter the existing profile name, you are prompted to confirm whether you want to overwrite it. If you 
want to, click [OK].
If you try to save more than 20 profiles, a dialog box notifying you that no more profiles can be saved 
appears, and then the 21st profile is saved as a temporary profile. If you want to register this temporary 
profile, delete unnecessary profiles first, and then select [Temporary Profile] to recall this profile and click 
[Save Profile] to save it.
You cannot specify [None] for the profile name.

4 The profile is saved.
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Loading profile

1 Select a profile in the [Profile] box.

The setting options in the profile are reflected on each tab.

To restore the default settings after you select the profile, click [Restore Defaults] on each tab. Selecting [None] 
on the [Profile] box will not restore them. To restore the default settings on any tab other than the [Fonts] and 
[Configuration] tabs, click [Restore All Defaults] on the [Others] tab.

Deleting profile

1 Select the profile that you want to delete in the [Profile] box, and click [Delete].

The [Confirm Delete] dialog box appears.

2 Click [Yes] to delete the selected profile.
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Print options
This section describes print options in each tab of the printer driver. This section will help you to find the description of 
specific print options, or understand the functions of each print option.

How to display:

1 Click the [Start] menu, [Control Panel], [Hardware and Sound] and select [Printer].
The Printers folder appears.

For Windows XP or Windows Server 2003
Click the [Start] menu and select [Printers and Faxes].
For Windows 2000
Click the [Start] menu, [Settings] and select [Printers].

2 Select the printer driver of this equipment, and then click the [File] menu and select 
[Printing Preferences].

If the [File] menu is not displayed, press [Alt].
The printing preferences dialog box appears.

1) Printer Name
Displays the name given to the printer driver when it was installed, or the name it displays on the icon in the Printer 
folder.

2) Menu Tabs
The menu items of the printer driver are displayed as tabs. Clicking on a tab will display the contents of the selected 
tab. The tabs displayed vary depending on the way the print properties are displayed.
- [Basic] tab

The [Basic] tab contains basic print operation settings, such as original paper size, print paper size, paper source, 
paper type, number of copies, orientation, and so on.

 P.24 “[Basic] tab”
- [Finishing] tab

The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, stapling and punching.
 P.27 “[Finishing] tab”

- [Paper Handling] tab
The [Paper Handling] tab contains Cover page printing.

 P.34 “[Paper Handling] tab”
- [Image Quality] tab

The [Image Quality] tab allows you to select how images are printed. You can easily select appropriate image 
quality depending on the type of job being printed.

 P.40 “[Image Quality] tab”

1

2

4

3

5

6

7 8 9 10
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- [Effect] tab
The [Effect] tab contains print options that add the effects to your print jobs such as Watermarks, Overlay Image 
printing and so on.

 P.41 “[Effect] tab”
- [Others] tab

The [Others] tab contains special features such as toner save, custom pager size, and so on.
 P.44 “[Others] tab”

- [Fonts] tab
The [Fonts] tab allows you to select how the TrueType fonts are printed. This tab is only displayed when the printer 
properties are accessed from the Printers folder.

 P.49 “[Fonts] tab”
- [Configuration] tab

The [Configuration] tab allows you to configure the options. When any optional unit is installed in this equipment, 
set the configuration of the machine on this tab. This tab is only displayed when the printer properties are accessed 
from the Printers folder.

 P.51 “[Configuration] tab”

3) Print Job
This option sets the type of print job.
- Normal Print

Select this option to print a job normally.
- Scheduled Print

Select this option to print a job at a specified date and time.
When this option is selected, click the button on the right to set the date and time to print a job.

- Private Print
Select this option to print a private job. When you select this option, enter a password using the alphanumeric 
characters and symbol characters (ASCII code characters between 0x21 to 0x7E) in the [Password] box that is 
displayed after the print settings have been made and the print job is sent. The password must be between 1 and 
63 characters.
The print job, sent as a private job, is saved in the private job queue on this equipment, and is not printed until you 
activate printing from the touch panel display. This option is useful when you want to print a confidential document 
that is secured by a password. The user has to enter the password to print the private job when activating printing 
from the touch panel display.

The private print function can be used when the user management setting is disabled on the equipment.

- Hold Print
The print job, sent as a hold job, is saved in the hold job queue on this equipment. To perform printing, select the 
desired job on the touch panel display and press [PRINT]. This option is useful to prevent you from forgetting to 
remove printed sheets.

- Proof Print
Select this option to print the first copy of a multicopy job and then wait for approval before printing the remaining 
copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are saved in the 
proof job queue on this equipment, which are not printed until you activate printing from the touch panel display. 
This option allows you to check a job’s output before printing the remaining copies and thereby reduces paper 
waste.

When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all 
the copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, 
and then specify the required number of copies on the touch panel display.

- Print to Overlay File
Select this option to save the print job as an overlay file that is imposed on other documents. When you select this 
option, click the button on the right and enter the file name.
For example, if you want to print a master page image on the background of a document, you can create an 
overlay file of the master merge image using this option. Then you can print a document using this overlay by 
specifying this file as an overlay image in the [Overlay Image] option of the [Effect] tab.
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If the print job has several pages in the document, only the first page of the document will be saved as an 
overlay file.
Both the overlay file and the documents on which you superimpose the overlay image must be created at the 
same size and orientation.
When creating an overlay file using the PS3 printer driver from an application that can create the PS command 
directly, the overlay file will not be created properly. In that case, disable the [Use PostScript Passthrough] 
option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

- Store to e-Filing
Select this option to save a job to e-Filing. When this option is selected, select the box after the print setting has 
been finished. When the SNMP communication is enabled, it detects the available box numbers and box name. If 
not, all are listed in the box.
If you select a user box, you may be required to enter the appropriate password for the selected box. The job saved 
to a box can be printed from the touch panel display at a later time. It can also be composed with other documents 
using the e-Filing web utility.
You can also print a job and save it to a box by checking on the [Print] option.

When you store a document in e-Filing using the printer driver, the printing image (not the original document in 
your computer) will be stored in e-Filing.
Documents stored in e-Filing are retained with the best image quality for printing. If you want to download them 
into your computer with a higher image quality, scan the original documents and store them in e-Filing.

For more information about e-Filing operations, refer to the e-Filing Guide.
For the detailed instructions on how to print with the [Print job] setting, see the following page:

 P.55 “Printing various print job types”

4) Preview window
In the Preview window, you can check the current settings in the printer driver. You can change the view type by 
clicking [Graphics] to display the print options settings graphically or [Text] to display the print option settings in text 
form.

5) Profile
Print option settings can be saved on your hard disk. You can save print option settings by clicking [Save Profile] and 
easily load a setting file by selecting a profile name in the box.

 P.18 “Setting print options using profiles”

There are 4 factory default profiles.

6) [Restore Defaults]
Click this button to restore the settings to the original factory defaults.

7) [OK]
Click this button to enter the input settings and complete the print option settings.

8) [Cancel]
Click this button to cancel the input settings and exit the print option settings.

9) [Apply]
Click this button to enter the input settings without closing the print option settings. This button is only displayed when 
the printer properties are accessed from the Printers folder. This button remains grayed out until a setting is changed.

10) [Help]
Click this button to browse the Help for the printer driver.
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[Basic] tab
The [Basic] tab contains basic print operation settings, such as the original paper size, print paper size, paper source, 
paper type, number of copies, orientation, and so on.

1) Original Paper Size
This option selects the size of a document to be printed.

There are also 20 custom paper sizes in the [Original Paper Size] box. You can set the custom paper sizes in 
the [Others] tab.

 P.44 “[Others] tab”
The default paper size will be [Letter] or [A4] according to the regional setting in Windows.

2) Print Paper Size
Select this option to enlarge or reduce a page image to fit exactly in the selected paper size. If you do not wish to 
enable enlarge or reduce printing, select [Same as Original Size].
Also when you want to enable Tab printing, select [Letter Tab] or [A4 Tab] here. When you select [Letter Tab] or [A4 
Tab], the [Primary Tab Dialog] dialog box appears.

 P.26 “Primary Tab Dialog”

There are also 20 custom paper sizes in the [Print Paper Size] box. You can set the custom paper sizes in the 
[Others] tab.

 P.44 “[Others] tab”

3) Manual Scale
Select this check box to manually enter the scale, to enlarge or reduce an image. The ratio can be set between 25% 
and 400%. This function cannot be used when Drawer or Large Capacity Feeder (optional) is selected for the Paper 
Source or the Booklet function is enabled.

For the detailed instructions on how to print with the [Manual Scale] setting, see the following page:
 P.62 “Fitting images within paper size”

Available original paper sizes are listed below:

Letter (8 1/2 x 11") 
Legal (8 1/2 x 14") 
Ledger (11 x 17") 
Statement (5 1/2 x 8 1/2") 
Computer (10 1/8 x 14") 
13"LG (8 1/2 x 13") 
8.5"SQ (8 1/2 x 8 1/2") 
Env-Com10 (4 1/8 x 9 1/2”)

Env-Monarch (3 7/8 x 7 1/2”)
A4 (210 x 297 mm)
A5 (148 x 210 mm)
A3 (297 x 420 mm)
B4 (257 x 364 mm)
B5 (182 x 257 mm)
Folio (210 x 330 mm)
A6 (105 x 148 mm)

Envelope DL (110 x 220 mm)
Envelope Cho-3 (120 x 235 mm)
Envelope You-4 (105 x 235 mm)
16K (195 x 270 mm)
8K (270 x 390 mm)
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4) Paper Source
This option selects the paper source. Please select a paper source that correlates with the printing size.
- Auto — Automatically selects the paper set in this equipment according to the printed document size.
- Drawer 1 — Paper is fed from the 1st Drawer.
- Drawer 2 — Paper is fed from the 2nd Drawer.
- Drawer 3 — Paper is fed from the 3rd Drawer (optional). This option can be selected when Drawer 3 (optional) and 

4 (optional) are installed.
- Drawer 4 — Paper is fed from the 4th Drawer (optional). This option can be selected when Drawer 3 (optional) and 

4 (optional) are installed.
- LCF — Paper is fed from the Large Capacity Feeder (optional). This option can be selected when the Large 

Capacity Feeder (optional) is installed.
- Bypass Tray — Paper is fed from the Bypass Tray. When you send a print job to the equipment with this option 

selected, [JOB STATUS] on the touch panel will blink. Press [JOB STATUS] and confirm the paper size of the job. 
Then set the paper and press the [START] button to print a job.

The Large Capacity Feeder (optional) is not available for some countries or regions.
The selectable values vary depending on the optional devices installed on this equipment and their 
configuration in the [Configuration] tab.
When the paper size settings in the [Configuration] tab differ from the paper size settings in the equipment, the 
paper source setting is ignored and the equipment may prompt to set the paper in the bypass tray.

5) Paper Type
This option sets the media type of the paper.
- Plain — Select this option when printing on 16 - 20 lbs plain paper (64 - 80 g/m2 plain paper).
- Thick1 — Select this option when printing on 20 - 28 lbs thick paper (81 - 105 g/m2 thick paper).
- Thick2 — Select this option when printing on 28 - 90 lbs thick paper (106 - 163 g/m2 thick paper).
- Thick3 — Select this option when printing on 90 - 110 lbs thick paper (164 - 209 g/m2 thick paper).
- Thin — Select this option when printing on 14 - 16 lbs thin paper (52 - 63 g/m2 thick paper).
- Transparency — Select this option when printing on transparent sheets.

When [A4 Tab] or [Letter Tab] is selected at the [Print Paper Size] box, [Tab] will be displayed and you cannot 
change the paper type.
When [Env-Com10], [Env-Monarch], [Envelope DL], [Envelope Cho-3], or [Envelope You-4] is selected at the 
[Print Paper Size] box, [Envelope] will be displayed and you cannot change the paper type.

For more information about the paper types that are available for this equipment, refer to the Quick Start Guide.

6) Number of Copies
This option specifies the number of printed copies. A number between 1 and 999 can be set .

7) Orientation
This option sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape — The document is printed in the landscape direction.
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Primary Tab Dialog

1) Tab Manufacturer
Select the product name of the tab paper that you use. This equipment supports following tab paper.

If you use tab papers other than those above, select [Custom]. When you select [Custom], you must specify the tab 
extension manually.

2) Tab Extension
Enter the width of the tab extension. This must be set only when [Custom] is selected in the [Tab Manufacturer] box.

3) Image Shift Width
Enter the width to shift the printed image.
For example, if you want to print text on the tab extension of Letter Tab paper, create a Letter sized document and 
input the text on the right side. Specify the distance the printed image is shifted in printing on tab paper.

When creating a document for tab printing, you must place the text at the exact height to fit the tab extension.
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches or 2.0 
mm of space because any information in this margin is not printed.

4) Units
Select the unit for the Tab Extension and Image Shift option. The default unit varies depending on the regional setting 
of the client computer.

For Letter Tab: Blanks USA copy Tabs (5 Banks) LT + 1/2" Tab
Blanks USA copy Tabs (8 Banks) LT + 1/2" Tab

For A4 Tab: KOKUYO A4-S (5 Banks)
King JIM A4-S (5 Banks)
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The tab paper cannot be fed from the Large Capacity Feeder (optional) and drawers.
When you place the tab paper on the Bypass Tray, make sure the tab side of the paper is facing outward. The job 
will be output to the exit tray.

If the document for tab printing is not created properly or the Image Shift Width is not set properly, the image will not 
be printed in the correct position within the tab extension. Make sure to create the document and set the Image 
Shift Width correctly.
If mis-printing occurs while multiple tab pages are printed continuously, dirt may adhere to the reverse side of 
paper. To avoid this, it is recommended to print tab paper as a separated job for each page so that this equipment 
performs cleaning before printing the next tab paper.
When printing the tab paper, it may be caught in the exit in the exit tray because the roller to deliver the tab 
extension does not exist. In this case, remove the tab paper before printing the next job.

For the detailed instructions on how to print on tab paper, see the following page:
 P.76 “Printing on tab paper”

[Finishing] tab
The [Finishing] tab allows you to enable sort printing, 2-sided printing, N-up printing, stapling and punching.

1) Copy Handling
This option sets how to sort the printed sheets when numerous copies are made for printing.
- Sort Copies — Select this option for sort-printing (1, 2, 3... 1, 2, 3...).

Place the tab paper

with the tab outward.
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- Group Copies — Select this option for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...).

- Rotated Sort Copies — Select this option for rotate sort-printing.

[Group Copies] and [Rotated Sort Copies] can be selected only when more than 1 copy is entered in the 
[Number of Copies] box.
[Rotated Sort Copies] can be selected only when [Letter], [A4], [B5], or [16K] is selected in the [Print Paper 
Size] box. When you use the “Rotated Sort Copies” option, place copy paper of a desired size in two drawers 
(portrait and landscape directions) before you start printing. Select one paper size from [Letter], [A4], [B5] and 
[16K], and then place the selected paper in two drawers or the Large Capacity Feeder (optional) trays in 
different directions (e.g. A4 and A4-R) in advance.

For the detailed instructions on how to print with the [Copy Handling] setting, see the following page:
 P.63 “Sort printing”

2) 2-Sided Printing
This option sets 2-Sided printing (printing on both sides of the paper) according to the type of binding for 2-sided-
printed pages.
This option is only for printing on both sides of the paper. If you want to bind the output with staples, you should set the 
finishing option as well.
- None — Select this option if you do not want to print on both sides of the paper.
- Book — Select this option to print on both sides of the paper in the same direction and to bind the document along 

the vertical side of the paper so that the pages can be turned over right and left.

- Tablet — Select this option to print on both sides of the paper with a vertical reversal and to bind the document 
along the horizontal side of the paper so that the pages can be turned over up and down.

- Booklet — Select this option to print a properly paginated booklet or magazine-style publication. When this option 
is selected, click [Details] to specify the details of the Booklet printing.

 P.32 “Booklet Details”
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2-Sided printing cannot be set when the following paper size is selected at the [Print Paper Size] box in the 
[Basic] tab.
- A6
- A4 Tab
- Letter Tab
- Env-Com10 (4 1/8 x 9 1/2”)
- Env-Monarch (3 7/8 x 7 1/2”)
- Envelope DL (110 x 220 mm)
- Envelope Cho-3 (120 x 235 mm)
- Envelope You-4 (105 x 235 mm)
- Custom Paper Size

2-Sided printing cannot be set when the following paper type is selected at the [Paper Type] box in the [Basic] 
tab.
- Thick2
- Thick3
- Transparency

When Booklet printing is performed using the PS3 printer driver from application that can create the PS 
command directly, the overlay image will not be printed. In that case, disable the [Use PostScript Passthrough] 
option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

For the detailed instructions on how to print with the [2-Sided printing] setting, see the following page:
 P.64 “Printing on both sides of a sheet”

3) Number of pages per sheet
This option sets the printing of multiple pages on one sheet. The pages are reduced to fit the selected paper size 
automatically and printed.
- 2 pages — Select this option to print images from 2 pages arranged on one sheet.
- 4 pages — Select this option to print images from 4 pages arranged on one sheet.
- 6 pages — Select this option to print images from 6 pages arranged on one sheet.
- 8 pages — Select this option to print images from 8 pages arranged on one sheet.
- 9 pages — Select this option to print images from 9 pages arranged on one sheet.
- 16 pages — Select this option to print images from 16 pages arranged on one sheet.

Direction of print
This option sets how the pages are arranged on one sheet.
- Left to Right — Select this option to arrange pages horizontally from the left and printed top to bottom on one 

sheet.
- Right to Left — Select this option to arrange pages horizontally from the right and printed top to bottom on one 

sheet.
- Left to Right by column — Select this option to arrange pages vertically from the top and printed left to right on 

one sheet.
- Right to Left by column — Select this option to arrange pages vertically from the top and printed right to left on 

one sheet.

Draw Borders Around Pages
Select this check box to print borders around each page.

The “N-up printing” option is not available when 2-Sided printing is selected together with the Booklet function.

For the detailed instructions on how to print with the [Number of pages per sheet] setting, see the following page:
 P.67 “Printing several pages on one sheet”

4) Staple
This option sets whether a print job is printed with staples.
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- Upper Left — Select this option to staple the printed document in the upper left.

- Upper Right — Select this option to staple the printed document in the upper right.

- Center Top — Select this option to double staple the printed document along the top edge.

- Middle Left — Select this option to double staple the printed document along the left side.

- Center Double — Select this option to fold and double staple the printed document in the center. When you select 
this option, the pages will be printed on the sheets according to the print option settings, and then simply folded and 
double stapled in the center of the sheets.

[Center Double] can be used to create a booklet from a document that has been already created as a paginated 
booklet. To create a paginated booklet from a normal document, perform the booklet printing in the 2-Sided Printing 
option.
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The selectable options vary depending on the paper size.
The “Staple” option is available only when the Finisher (optional) is installed.
[Center Double] can be selected only when the Saddle Stitch Finisher (optional) is installed.
The “Staple” option is not available when 2-Sided printing is selected together with the Magazine sort function.
Stapling cannot be set when the following paper sizes are selected in the [Print Paper Size] box in the [Basic] 
tab.
- A5
- A6
- Statement
- A4 Tab
- Letter Tab
- Env-Com10 (4 1/8 x 9 1/2”)
- Env-Monarch (3 7/8 x 7 1/2”)
- Envelope DL (110 x 220 mm)
- Envelope Cho-3 (120 x 235 mm)
- Envelope You-4 (105 x 235 mm)
- Custom Paper Size

Stapling cannot be set when [Transparency] is selected in the [Paper Type] box in the [Basic] tab.
Stapling using the Saddle Stitch Finisher (optional) is not supported in the following cases:
- MJ-1024 for e-STUDIO355/455

[Thick2] or [Thick3] is selected in the [Paper Type] box in the [Basic] tab with the [Center Double] option 
selected.

- MJ-1025 for e-STUDIO205L/255/305
[Thick2] is selected in the [Paper Type] box in the [Basic] tab with the [Center Double] option selected.
[Thick3] is selected in the [Paper Type] box in the [Basic] tab with any of the Staple options selected.

For the detailed instructions on how to print with the [Staple] setting, see the following page:
 P.68 “Stapling”

5) Hole Punch
This option sets whether a print job is printed with hole punches.
- Center Top — Select this option to create holes along the top edge and print.

- Middle Left — Select this option to create holes along the left side and print.

Hole punching can be selected only when a Hole Punch Unit (optional) is installed.
The “Hole Punch” option is not available when 2-Sided printing is selected together with the Booklet function.
The selectable options vary depending on the paper size.

For the detailed instructions on how to print with the [Hole Punch] setting, see the following page:
 P.69 “Hole punching”
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6) Use Custom Margin
Select this check box to set the margin on the printed pages. When this box is selected, click [Details] to set the 
margins in the [Custom Margin] dialog box.
The margin range is between 4.2 mm and 100 mm (0.17 inches and 3.94 inches). Less than 4.2 mm cannot be set for 
the range.

If [Booklet] is selected on [2-Sided Printing], this option will be disabled.
Enable this option to add the margins if the application does not support the margin function. When the 
application has the margin function, use the application’s function rather than this option.
This option cannot specify the binding margin for Booklet printing.

Booklet Details
In the [Booklet Details] dialog box, you can specify how Booklet printing is performed.

1) Output Document Layout
Select the booklet size to be made.
- Letter-Half on Letter — Select this option to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter 

paper to fit on half a sheet.
- LT on LD — Select this option to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit on half 

a sheet (Letter).
- 1/2 LG on LG — Select this option to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit 

on half a sheet.
- 1/2 Statement on Statement — Select this option to print a 1/2 Statement size booklet. Every 2 pages are printed 

on Statement paper to fit on half a sheet.
- 1/2 Comp on Comp — Select this option to print a 1/2 Computer size booklet. Every 2 pages are printed on 

Computer paper to fit on half a sheet.
- 1/2 13LG on 13LG — Select this option to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch 

LG paper to fit on half a sheet.
- 1/2 8.5SQ on 8.5SQ — Select this option to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 

inch SQ paper to fit on half a sheet.
- A5 on A4 — Select this option to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a 

sheet (A5).
- A4 on A3 — Select this option to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half a 

sheet (A4).
- B5 on B4 — Select this option to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a 

sheet (B5).
- B6 on B5 — Select this option to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a 

sheet (B6).
- 1/2 Folio on Folio — Select this option to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to 

fit on half a sheet.
- A6 on A5 — Select this option to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a 

sheet (A6).
- 32K on 16K — Select this option to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half 

a sheet.
- 16K on 8K — Select this option to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half a 

sheet.

2) Page Order
Select this option to print the pages from left to right or right to left.
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3) Margin - Center
This option sets the gutter in the center of a two sided page. You can enter up to 0.50 inches (12.70 mm). The printed 
images will be reduced according to the margin setting.

4) Margin - Outer
This option sets the gutter on the right side and left side on the paper. You can enter up to 1.00 inch (25.40 mm). The 
printed images will be reduced according to the margin setting.

5) Units
Select the unit for the Center Margin and Outer Margin options. The default unit varies depending on the regional 
setting in Windows.

6) Staple Down the Center
Select this check box to double staple in the center.

[Staple Down the Center] is available only when [A5 on A4], [A4 on A3], [B5 on B4], [Letter - Half on Letter], [LT on 
LD], or [1/2 LG on LG] is selected at the [Output Document Layout] box and the Saddle Stitch Finisher (optional) is 
installed.

7) [Restore Defaults]
 Click this button to restore the settings displayed in the [Booklet Details] dialog box to the original factory defaults.

For the detailed instructions on how to print with the [Booklet] setting, see the following page:
 P.65 “Making a booklet”
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[Paper Handling] tab
The [Paper Handling] tab allows you to enable Front Cover printing, Back Cover printing, Inserting Pages, and Interleaving 
Pages.

“Use Front Cover”, “Use Back Cover”, “Insert Pages” and “Interleave Pages” are not available when the Tab 
printing function is set. 
When the size of covers or sheets to be inserted is the same as that of the copy paper, change the media type or 
specify “Paper Source” on the [Basic] tab menu; otherwise all data will be printed from the insertion drawer.
If you select [Store to e-Filing] in the [Print Job] box, [Use Front Cover], [Use Back Cover], [Insert Pages] and 
[Interleave Pages] are unselectable. 

1) Destination
This option selects the destination tray to which jobs will be output.
- Exit Tray — Select this option to route the output to the exit tray.
- Tray 1 — Select this option to route the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this option to route the output to the lower tray of the Finisher (optional).
- Job Separator Upper — Select this option to route the output to the upper tray of the Job Separator (optional).
- Job Separator Lower — Select this option to route the output to the lower tray of the Job Separator (optional).

For e-STUDIO355/455, [Tray 1] and [Tray 2] can be selected when the Finisher (optional) or Saddle Stitch 
Finisher MJ-1024 (optional) is installed and configured in the [Configuration] tab. When the Hanging Finisher 
(optional) is installed, only [Tray 1] can be selected.
For e-STUDIO205L/255/305, only [Tray 1] can be selected when the Hanging Finisher (optional) or Saddle 
Stitch Finisher MJ-1025 (optional) is installed and configured in the [Configuration] tab.
When the Job Separator (optional) is installed and configured in the [Configuration] tab, you can select [Job 
Separator Upper] and [Job Separator Lower] instead of [Exit Tray].
When [A6] is selected in the [Print Paper Size] box, the printed paper will be always output to [Job Separator 
Lower].

2) Use Front Cover
This option sets front cover printing which allows you to insert or print a cover on a sheet fed from a different Drawer or 
Bypass tray than the Paper Source option selected in the [Basic] tab.
To enable cover printing, select the check box and select the location from where a cover sheet is to be fed and the 
print style to be used.

For the detailed instructions on how to print with the [Use Front Cover] setting, see the following page:
 P.70 “Inserting different types of paper”

Source
Select the location from where a front cover sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.
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The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the [Configuration] tab.

Print Style
This option selects how you want to print a front cover.
- Do not print on page — Select this option to insert a blank cover.
- Print one side of the page — Select this option to print the first page image on the front side of a cover.
- Print both sides of page — Select this option to print the first two page images on both sides of a cover. This 

option is available only when the 2-Sided Printing option is enabled on the [Finishing] tab.

If [Print one side of the page] is selected while 2-Sided Printing is performed, the first page is printed on the front 
side of the cover sheet and the back side of the cover will be blank.

3) Use Back Cover
This option sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different 
Drawer or Bypass tray than the Paper Source option selected in the [Basic] tab.
To enable back cover printing, select the check box and select the location from where a back cover sheet is to be fed 
and the print style to be used.

For the detailed instructions on how to print with the [Use Back Cover] setting, see the following page:
 P.70 “Inserting different types of paper”

Source
Select the location from where a back cover sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the [Configuration] tab.

Print Style
This option selects how you want to print a back cover.
- Do not print on page — Select this option to insert a blank cover.
- Print one side of the page — Select this option to print the last page image on the front side of a cover.
- Print both sides of page — Select this option to print the last two page images on both sides of a cover. This 

option is available only when the 2-Sided Printing option is enabled on the [Finishing] tab.

If [Print one side of the page] is selected while 2-Sided Printing is performed, the last page is printed on the 
front side of the cover sheet and back side of the cover will be blank.
If [Print both sides of page] is selected but there is only one page printed on the back cover, the last page is 
printed on the front side of the cover sheet and back side of the cover will be blank.
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4) Insert Pages
This option sets sheet insertion printing which allows you to insert a sheet between pages, or print a specific page on a 
sheet fed from a tray other than the Paper Source option selected in the [Basic] tab.
This option is useful when you want to insert a blank sheet between chapters, or when you want to print chapter cover 
pages on different paper.
To enable sheet insertion printing, select the check box and click [Edit] to set how the pages are inserted in the [Insert 
Pages] dialog box.

 P.37 “Insert Pages”

This option cannot be set when the [Interleave Pages] option is enabled.
This option cannot be set with N-up printing.
Up to 50 pages can be inserted.
When Insert Pages printing is performed using the PS3 printer driver from an application that can create the PS 
command directly, the interleaving sheets may not be inserted between the designated pages. In that case, 
disable the [Use PostScript Passthrough] option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

For the detailed instructions on how to print with the [Insert Pages] setting, see the following page:
 P.70 “Inserting different types of paper”

5) Interleave Pages
This option sets the interleaving page feature that is useful when you want to insert paper of a different type (or from 
another source) between every page of your print job. For example, you can use this option to insert blank, colored 
sheets between overhead transparencies.
To enable interleaving pages, select the check box and select the location from where sheets are to be fed.

When this option is enabled as well as the [Use Front Cover] and [Use Back Cover] options are enabled, no 
page is inserted after the front cover and back cover.
This option cannot be set when the [Insert Pages] option is enabled.

For the detailed instructions on how to print with the [Interleave Pages] setting, see the following page:
 P.71 “Interleaving pages”

Source
Select the location from where the interleaving sheet is to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the [Configuration] tab.

Duplicate
When you select this check box, you can print previous page images on the inserted sheet.
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Insert Pages

1) Page
Enter the page number where the sheet is to be inserted.
When [Blank] is selected from the [Print Style] box, the blank sheet is inserted before the entered pages.
When [1 Side] is selected from the [Print Style] box, the entered page will be printed on the inserted sheet.

A sheet cannot be inserted before the first page when 2-Sided printing is enabled.

2) Print Style
This option selects how you want to print on insertion sheets.
- Blank — Select this option to insert blank sheets.
- 1 Side — Select this option to print the specified page on the front side of the insertion sheets.
- 2 Sides — Select this option to print the specified page and the next page on both sides of the insertion sheets.

3) Paper Source
Select the location from where insertion sheets are to be fed. When [Auto] is selected, the paper is automatically 
selected according to the printed document size.

The selectable values in the [Paper Source] box vary depending on the optional devices installed on this 
equipment and their configuration on the [Configuration] tab.

4) Paper Type
Select the paper type to be inserted.

5) Use Tab Paper
Select this check box when you insert a sheet of tab paper between two specified pages or print the data of the 
specified page in originals on the inserted tab paper.

6) Tab Manufacturer
Select the product name of the tab paper that you use. This equipment supports the following tab paper.

If you use tab paper other than those above, select [Custom]. When you select [Custom], you must specify the tab 
extension manually.

7) Number of tabs per Bank
Enter the number of tabs for each tab set.

8) Tab Extension
Enter the width of the tab extension. This must be set only when [Custom] is selected in the [Tab Manufacturer] box.

For Letter Tab: Blanks USA copy Tabs (5 Banks) LT + 1/2" Tab
Blanks USA copy Tabs (8 Banks) LT + 1/2" Tab

For A4 Tab: KOKUYO A4-S (5 Banks)
King JIM A4-S (5 Banks)

1

2 4

7

8

9

10

3

5
6



2 PRINTING FROM WINDOWS

38    Setting Up Print Options

9) Image Shift Width
Enter the width to shift the printed image.
For example, if you want to print text on the tab extension of Letter Tab paper, create a Letter sized document and 
input the text on the right side. Specify the distance the printed image is shifted in printing on tab paper.

When creating a document for tab printing, you must place the text at the exact height to fit the tab extension.
The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches or 2.0 
mm of space because any information in this margin is not printed.

10)Units
Select the unit for the Tab Extension and Image Shift option. The default unit varies depending on the regional setting 
of the client computer.

The tab paper cannot be fed from the Large Capacity Feeder (optional) and drawers.
When you place the tab paper on the Bypass Tray, make sure the tab side of the paper is facing outward. The job 
will be output to the exit tray.

If the document for tab printing is not created properly or the Image Shift Width is not set properly, the image will not 
be printed in the correct position within the tab extension. Make sure to create the document and set the Image 
Shift Width correctly.
If mis-printing occurs while multiple tab pages are printed continuously, dirt may adhere to the reverse side of 
paper. To avoid this, it is recommended to print tab paper as a separated job for each page so that this equipment 
performs cleaning before printing the next tab paper.
When printing the tab paper, it may be caught in the exit in the exit tray because the roller to deliver the tab 
extension does not exist. In this case, remove the tab paper before printing the next job.
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If [Blank] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper) for the [Pages] box, the specified page will be blank. The desired blank sheet is inserted 
next and the 2-sided printing continues from the next page.

If [1 Side] is selected while 2-sided printing is performed, the specified page is printed on the front side of the sheet 
and back side of the sheet will be blank.

If [1 Side] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper) for the [Pages] box, the specified page will be blank. The page is printed on the front side of 
the inserted sheet and the 2-sided printing continues from the next page.

If [2 Sides] is selected while 2-sided printing is performed, and you enter an even numbered page (printed on the 
back side of the paper) for the [Pages] box, the specified page will be blank. The specified page and the next page 
are printed on the inserted sheet and the 2-sided printing continues from the next page.
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[Image Quality] tab
The [Image Quality] tab allows you to select how images are printed. You can easily select appropriate image quality 
depending on the type of document.

1) Halftone
This option sets how halftones are printing.

PCL6 Printer Driver
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

PS3/XPS Printer Driver
- Auto — Select this option to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.

4) Use Black for All Text
Select this check box to print all texts in 100% black except white texts.
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[Effect] tab
The [Effect] tab contains print options that add effects to your print jobs such as Watermarks, Overlay Image printing, 
Rotate printing, Mirror printing, and Negative printing.

[Effect] tab for PCL6

[Effect] tab for PS3/XPS

1) Watermark
This option selects the watermark to be used or edited. The following values except [None] are the default watermarks 
that have been registered in the printer driver. Up to 15 new watermarks can be added in this box.
- None — Select this option if no watermark is desired.

The following default watermarks are also displayed in the box:
- TOP SECRET
- CONFIDENTIAL
- DRAFT
- ORIGINAL
- COPY

For the detailed instructions on how to print with the [Watermark] setting, see the following page:
 P.72 “Printing with watermarks”
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[Add]
Click this button to create a new watermark. The [Watermark] dialog box will appear upon clicking this button.

 P.43 “Add/Edit Watermark”

[Edit]
Select a watermark from the [Watermark] box and click [Edit] to edit the watermark. The [Watermark] dialog box will 
appear upon clicking this button.

 P.43 “Add/Edit Watermark”

[Delete]
Select a watermark from the [Watermark] box and click [Delete] to delete a watermark.

 P.74 “Deleting a watermark”

The default watermarks can be deleted but, once deleted, they cannot be restored.
[None] cannot be deleted.

Print on First Page Only
Select this check box to print a watermark on the first page only. This setting will become available when any 
watermark is selected from the [Watermark] box.

2) Overlay Image
This option selects an overlay image to be used. This feature allows you to print an image on the background of a print 
job, although the watermark allows only text.

When [Overlay Image] is selected together with the N in 1 function, 1 overlay image will be printed on the entire 
page, regardless of the number of images set in 1 page.
Both the overlay file and the documents on which you superimpose the overlay image must be created at the 
same size, color mode and orientation.
When printing with Overlay Image using the PS3 printer driver from an application that can create the PS 
command directly, the overlay image will not be printed. In that case, disable the [Use PostScript Passthrough] 
option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

If you want to use an overlay image in your print job, you must first create an overlay file. Using most 
applications, you can create an overlay image and print. You can enable creating an overlay file on the [Print 
Job] box.

 P.59 “Printing a document as an overlay file”
For the detailed instructions on how to print with the [Overlay Image] setting, see the following page:

 P.74 “Printing with an overlay file”

[Delete]
Click this button to delete the overlay image that you select in the box.

 P.75 “Deleting an overlay image”

Print Over the Document
Select this check box to print the overlay image over the document.

3) Rotate 180 degrees
Select this check box to perform rotation printing of an image.

4) Mirror
Select this check box to perform mirror printing of an image.

This print option is not displayed for the PCL6 printer driver.
Mirror printing may not be applied when the application gives priority to the application’s PostScript settings 
over the printer driver settings.
When printing from Adobe Acrobat or similar applications, mirror printing does not work if the [Use PostScript 
Passthrough] option is enabled in the PostScript settings. To use mirror printing, disable the [Use PostScript 
Passthrough] option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”
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5) Negative/Positive
Select this check box to perform negative printing of an image.

This print option is not displayed for the PCL6 printer driver.
Negative printing may not be applied when the application gives priority to the application’s PostScript settings 
over the printer driver settings.
When printing from Adobe Acrobat or similar applications, Negative/Positive printing does not work if the [Use 
PostScript Passthrough] option is enabled in the PostScript settings. To use Negative/Positive printing, disable 
the [Use PostScript Passthrough] option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

Add/Edit Watermark
When you click [Add] or [Edit], the [Watermark] dialog box appears and you can create a new watermark or edit selected 
watermarks.

1) X Position
The horizontal position of a watermark is displayed. You can change the position using the horizontal scroll bar.

2) Y Position
The vertical position of a watermark is displayed. You can change the position using the vertical scroll bar.

3) Units
Select the unit for the [X Position] and [Y Position] box.

4) [Center Watermark]
Click this button to automatically move the watermark position to the center.

5) Caption
Enter the text of the watermark. You can enter up to 63 alphanumeric characters. When you are editing a watermark, 
the selected watermark text is displayed in the box.

6) Font Name
Select the font to be used for the watermark text.

7) Style
Select the font style for the watermark text.
- Regular — Select this option to set the regular style to the text.
- Bold — Select this option to set the bold style to the text.
- Italic — Select this option to set the italic style to the text.
- Bold Italic — Select this option to set the bold and italic style to the text.

8) Font Size
Enter the font size for the watermark text. The font size can be set from 6 to 300 pt in units of 1 pt.

9) Angle
Enter the degree of the angle for rotating the watermark text. The angle can be set from -90 to 90 degrees in units of 1 
degree. You can also set the degree of angle by moving the scroll bar.

10)Solid
Select this option to print a solid type of watermark.
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11) Draw as Outline
Select this option to print an outline type of watermark.

12)Transparency
Select this option to print a transparent watermark. When you select this option, set the transparency from 0 (darker) to 
100% (lighter) in units of 1%. You can also set the transparency using the scroll bar.

13) [Restore Defaults]
 Click this button to restore the settings displayed in the [Watermark] dialog box to the original factory defaults.

[Others] tab
The [Others] tab contains print options such as toner saving, custom paper size and so on.

[Others] tab for PCL6/XPS

[Others] tab for PS3

1) Default Menu Setting
Select the default tab that is displayed when opening the properties of the printer driver. Set functions frequently used 
as a default menu setting for your convenience.

If you made settings on the [Others] tab menu from the print setting page of an application, the settings are 
temporary. If you want to keep the adjusted settings every time you open the printer driver menus, set the printer 
driver from the [Printers] folder.

 P.18 “Setting initial values of print options”
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2) Toner Save
Select this check box to print in toner save mode.

When the toner save mode is enabled, printing may become lighter.

3) Do not Print Blank Pages
Select this check box to ignore blank pages for printing. 
If Watermark feature is enabled all pages will be printed even when the content is blank.

The pages having a header or footer will be printed even if the content is blank.

4) Letterhead Print Mode
Select this check box to perform duplex printing on paper whose sides need to be distinguished, such as paper with 
illustrations on one side.
If the Watermark feature is enabled all pages will be printed even when the content is blank. 

5) [Custom Paper Size]
Click this button to specify the custom paper size. When you click this button, the [Custom Paper Size] dialog box 
appears.

 P.47 “Custom Paper Size”

To set a custom paper size, you must log in as a user with an administrator privilege or with a power user privilege 
(In the case of Windows 2000).Then access the printer driver properties from the Printers folder (or the Printers 
and Faxes folder in the case of Windows XP/Server 2003). When you access the printer driver properties from an 
application’s print dialog box, you cannot add or reduce the custom paper size.

6) [PostScript Settings]
Click this button to specify the PostScript specific functions. The [PostScript Settings] dialog box appears upon clicking 
this button.

 P.48 “PostScript Settings”

This print option is available only for the PS3 printer driver.

7) [TopAccess]
Click this link to start a web browser and display the TopAccess menu.

8) User name (Alias)
Enter a nickname as required, which is displayed on the Private Print job list and Hold Print job list. You can specify the 
desired name so that you can easily find the target job from the job list when releasing it from the equipment’s touch 
panel.

Up to 31 characters can be entered for the [User name (Alias)] box.
The user name that is entered to log in to your computer is initially used for [User name (Alias)]. If the user  
name is not changed, the login user name is displayed on the Private Print job list and Hold Print job list.
The nickname entered for the [User name (Alias)] box is applied only to the Private Print job list and Hold Print 
job list. On other job list screens (Scheduled Print jobs/Invalid jobs) and the Print Log screen, the login user 
name is always displayed.

9) Department
Enter the user’s department code if the system is managed with department codes. Ask your administrator for your 
department code.
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When the User Management Setting is enabled on the equipment, the User Management Setting is used to 
manage the print jobs instead of the department code. In that case, the user name that is entered to log in to 
your computer is used for the authentication of the print job. Therefore, you do not need to enter the department 
code in the printer driver but your user name must be registered in the equipment. If the user name is not 
registered, your print job is processed as an invalid job according to the Department Code Enforcement 
settings.
If the number of the printed sheets for a print job exceeds the output limitation for the entered department code, 
the print job is stored in the invalid department code print job list without printing. When you want to print the 
print job, perform printing from [JOB STATUS] on the touch panel by entering another department code for 
which the output limitation is more than the number of printed sheets.

How the equipment performs printing for an invalid department code print job, which an invalid department code is 
specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode and whether SNMP Communication is enabled or not. When SNMP Communication is 
enabled and Department Code Enforcement is set to [ON], an error message will be displayed when entering an 
invalid department code. When SNMP Communication is disabled and Department Code Enforcement is set to 
[ON], the invalid department code print job will be stored in the invalid department code print job list without 
printing. When the Department Code Enforcement is [Print], the invalid department code print job will be printed. 
When the Department Code Enforcement is [Delete], the invalid department code print job will be deleted without 
printing.

10) [Import]
Click this button to import custom settings (e.g. custom paper size, image quality type, watermark, overlay, profiles) to 
the printer driver.

How to import custom settings
- Click [Import]. A dialog box to select a file appears. Select a file (*cfx for PCL6, *cfp for PS3, *cfv for XPS) to be 

imported.
- Click [Open]. A dialog box to confirm if you overwrite the file appears. Click [OK].

To start importing, select a printer driver for this equipment in the [Printers] folder. Then click the [File] menu, 
[Run as administrator] and select [Properties] and then click [Printing Preferences]. Enter the administrator 
password if required.
- If the [File] menu is not displayed, press [Alt].
- Click [Continue] in the [User Account Control] dialog box.

You need to log into Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” 
privilege (for Windows 2000/XP/Vista/Server 2003/Server 2008) to open the properties page of the printer 
driver.

11) [Export]
Click this button to export custom settings (e.g. custom paper size, image quality type, watermark, overlay, profiles) 
from the printer driver.

How to export custom settings
- Click [Export].
- The [Save as] dialog box will appear. Specify a file name and a directory, and click [Save].

To start exporting, select a printer driver for this equipment in the [Printers] folder. Then click the [File] menu, 
[Run as administrator] and select [Properties] and then click [Printing Preferences]. Enter the administrator 
password if required.
- If the [File] menu is not displayed, press [Alt].
- Click [Continue] in the [User Account Control] dialog box.

You need to log into Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” 
privilege (for Windows 2000/XP/Vista/Server 2003/Server 2008) to open the properties page of the printer 
driver.

12) [Version Information]
Click this button to display the [Version Information] dialog box.
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13) [Restore All Defaults]
Click this button to return settings in all the tab menus other than the [Font] and [Configuration] tab menus to the 
default ones. When you click this button, a confirmation dialog box will appear. Click [OK] on the dialog box to return 
print settings in all the tab menus to the default ones.

If you want to change the settings in the [Font] and [Configuration] tab menus, you need to access the settings with 
the administrator privilege from the Printers folder. For the details, see the following page:

 P.49 “[Fonts] tab”
 P.51 “[Configuration] tab”

Custom Paper Size
In the [Custom Paper Size] dialog box, up to 20 custom paper sizes can be defined. The custom paper size that you 
specify can be selected in the [Original Paper Size] and [Print Paper Size] box in the [Basic] tab.

1) Paper Size List
Select the custom paper size that you want to modify.

2) Name
Enter the custom paper size name. You can enter up to 63 characters. This name will be displayed in the [Original 
Paper Size] and [Print Paper Size] box in the [Basic] tab.

3) Paper Size
Enter A (Length) and B (Width) to specify the paper size.

4) Units
Select the unit for the paper size. The default unit varies depending on the regional setting in Windows.

5) [Add]
Click this button to save the settings over the selected custom paper size that you selected in the [Paper Size List].

6) [Delete]
Click this button to clear and restore the default settings of the selected custom paper size that you selected in the 
[Paper Size List]. When you click this button, the confirmation dialog box appears. Click [Yes] to delete the setting.

To register a custom paper size, either A (Length) or B (Width) should be different by more than 0.1 inches (2 
mm) from the standard paper size. If not, the created custom paper size is considered as the standard paper 
size.
You cannot create a custom paper size with A (Length) longer than B (Width). If you want to print such a 
document, print the document by selecting [Landscape] for the [Orientation].
There are some precautions when you use paper larger than standard sizes. For the details, see the following 
page:

 P.78 “Printing on paper larger than standard sizes”
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PostScript Settings

1) Output Format
This option selects the output format for printing.
- ASCII — Select this option to send in ASCII data format.
- Encapsulated PostScript (EPS) — Select this option to send in EPS format.
- Tagged BCP — Select this option to send a job in Tagged Binary format over parallel ports.
- Using Adobe DSC — Select this option to send a job with DSC comments.

The EPS format is usually used for creating an image to import into another document. Therefore, only the first 
page of the document will be printed when [Encapsulated PostScript (EPS)] is selected. An exit tray where paper is 
output is set by the administrator. For the details, ask your administrator. 

2) Print Error Information
Select this check box to print a PS error information page when any errors occur for printing.

3) Compress Bitmap
Select this check box to send compressed bitmaps to this equipment.

4) Use PostScript Passthrough
Select this check box for PostScript data created by the application that creates the PostScript code for printing (such 
as Adobe Acrobat, Adobe Photoshop, or Adobe Illustrator) to be passed through to this equipment.

If this option is enabled, the following print options may not work correctly when printing from an application that 
creates the PostScript code for printing such as Adobe Acrobat. In that case, disable this option for printing.
- Manual Scale
- Print Paper Size
- Paper Type
- Use Front Cover
- Use Back Cover
- Interleave Pages
- Insert Pages
- Booklet
- Multiple Pages per Sheet
- All options in the [Effect] tab
- All options in the [Image Quality] tab
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[Fonts] tab
The [Fonts] tab allows you to select how the TrueType fonts are printed. The [Fonts] tab can be displayed only from the 
Printers folder (and not displayed when displaying the properties from the application’s print dialog box).

To adjust settings in the [Font] tab menu, you need to select the printer driver of this equipment in the Printers 
folder, and then click the [File] menu, [Run as administrator] and select [Properties].
Enter the administrator password if required.
- If the [File] menu is not displayed, press [Alt].
- If the [User Account Control] dialog box is displayed, click [Continue] in this dialog box.

You need to log into Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” privilege 
(for Windows 2000/XP/Vista/Server 2003/Server 2008) to open the properties page of the printer driver.

[Fonts] tab for PCL6/PS3

[Fonts] tab for XPS
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1) TrueType Options
This option sets how to print TrueType fonts.
- Always Use TrueType Fonts — Select this option to print the document the same as the print image shown on the 

screen. All TrueType fonts are extracted on the system for printing.
- Always Use Printer Fonts — Select this option to substitute the TrueType fonts with the internal fonts for printing. 

The print result may differ from the print image on the screen.
- Use Font Substitution Table — Select this option to substitute the TrueType fonts using the internal fonts 

according to the settings of the font substitution table. You can edit the font substitution table that is displayed at the 
Substitution Table Edit table.

- Download as Bitmap — Select this option to print the document as the same as the image shown on the screen.

The default value will be [Always Use TrueType Fonts] for the PCL6 printer driver.
The default value will be [Use Font Substitution Table] for the PS3 printer driver.
When you are using XPS printer driver, only [Always Use TrueType Fonts] appears.

2) Substitution Table Edit
This table shows how each TrueType font is substituted. You can edit the substitution setting for each TrueType font. In 
this table, the TrueType font names are displayed in the TrueType Font column, and how the TrueType font is printed 
is shown in the Use Printer Font column.
To edit the substitution table, select the TrueType font that you want to edit from the table, and select how the TrueType 
font is to be printed in the [Substitute Printer Font For] box.
In the [Substitute Printer Font For] box, you can select [Download as Soft Font] to send the TrueType fonts in Type 42 
format, or other available printer fonts to be substituted. The printer fonts displayed in the box differ depending on the 
TrueType fonts.

The [Substitution Table Edit] option is not displayed for the XPS printer driver.
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[Configuration] tab
The [Configuration] tab allows you to configure options. When any optional unit is installed in this equipment, set the 
configuration of the machine on this tab. The [Configuration] tab can be displayed only from the Printers folder (and not 
displayed when displaying the properties from an application’s print dialog box).

To adjust settings in the [Configuration] tab menu, you need to select the printer driver of this equipment in the 
Printers folder, and then click the [File] menu, [Run as administrator] and select [Properties].
Enter the administrator password if required.
- If the [File] menu is not displayed, press [Alt].
- If the [User Account Control] dialog box is displayed, click [Continue] in this dialog box.

You need to log into Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” privilege 
(for Windows 2000/XP/Vista/Server 2003/Server 2008) to open the properties page of the printer driver.

1) Model Selection
This option sets the model name of the equipment.
- e-STUDIO455/e-STUDIO355/e-STUDIO305/e-STUDIO255/e-STUDIO205L

2) Option
This option sets whether the following optional devices are installed.

Drawers
This option sets whether or not the optional drawers or Large Capacity Feeder are installed.
- Drawer 1 — Select this option when Drawer 1 is installed.
- Drawer 1 & LCF — Select this option when Drawer 1 and the Large Capacity Feeder (optional) are installed.
- Drawer 1 & Drawer 3 — Select this option when Drawer 1 and Drawer 3 (optional) are installed.
- Drawer 1 & Drawer 3, 4 — Select this option when Drawer 1 and Drawer 3, 4 (optional) are installed.
- Drawer 1 & Drawer 2 — Select this option when Drawer 1 and Drawer 2 are installed.
- Drawer 1, 2 & Drawer 3 — Select this option when Drawer 1, 2 and Drawer 3 (optional) are installed.
- Drawer 1, 2 & Drawer 3, 4 — Select this option when Drawer 1, 2 and Drawer 3, 4 (optional) are installed.
- Drawer 1,2 & LCF — Select this option when Drawer 1, 2 and the Large Capacity Feeder (optional) are installed.

The Large Capacity Feeder (optional) is not available for some countries or regions.

Finisher
This option sets whether or not the Finisher (optional) is installed.

For e-STUDIO355/455:
- None — Select this option when a Finisher (optional) is not installed.
- Finisher — Select this option when the Finisher (optional) is installed.
- Hanging Finisher — Select this option when the Hanging Finisher (optional) is installed.
- Saddle Stitch Finisher — Select this option when the Saddle Stitch Finisher MJ-1024 (optional) is installed.
- Job Separator — Select this option when the Job Separator MJ-5006 (optional) is installed.

For e-STUDIO205L/255/305:
- None — Select this option when a Finisher (optional) is not installed.
- Hanging Finisher — Select this option when the Hanging Finisher (optional) is installed.
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- Saddle Stitch Finisher — Select this option when the Saddle Stitch Finisher MJ-1025 (optional) is installed.
- Job Separator — Select this option when the Job Separator MJ-5004 (optional) is installed.
- Offset Tray — Select this option when the Offset Tray (optional) is installed.

Hole Punch Unit
This option sets whether or not the Hole Punch Unit (optional) is installed.
- None — Select this option when a Hole Punch Unit (optional) is not installed.
- 2 Holes — Select this option when a 2 Hole Punch Unit (optional) is installed.
- 2/3 Holes — Select this option when a 2/3 Hole Punch Unit (optional) is installed.
- 4 Holes (F) — Select this option when a 4 Hole (F) Punch Unit (optional) is installed.
- 4 Holes (S) — Select this option when a 4 Hole (S) Punch Unit (optional) is installed.

3) Enable SNMP Communication
Select this check box to enable obtaining the configuration information from this equipment.

If you disable SNMP Communication, TopAccessDocMon notification will be also disabled.

Update Automatically/Manual
Select the method to update the configuration information of the printer driver. This option is available only when the 
[Enable SNMP Communication] check box is selected.
- Update Automatically— Select this option to update the option configuration information automatically every time 

the [Configuration] tab menu of the printer driver is opened.
- Manual — Select this option to update the option configuration information manually.

If the connection to the equipment has not been configured correctly, the message “The address of your printer 
could not be located. Would you like to find it?” will be displayed when the [Configuration] tab is displayed. If it is 
displayed, click [Yes] and search for the equipment using the [Local Discovery] dialog box. After searching for the 
equipment, SNMP communication will be enabled.

[Update Now]
Click this button to obtain the configuration information from this equipment immediately. This button is available only 
when the [Enable SNMP Communication] check box is selected.

If the connection to the equipment has not been configured correctly, the message “The address of your printer 
could not be located. Would you like to find it?” will be displayed when you click [Update Now]. If it is displayed, 
click [Yes] and search for the equipment using the [Local Discovery] dialog box. After searching for the equipment, 
SNMP communication will be enabled.

4) [Drawer Settings]
Click this button to set the paper size and paper type of each drawer. The [Drawer Settings] dialog box appears upon 
clicking this button.

 P.53 “Drawer Settings”

5) [Account Settings]
Click this button to set whether the user management setting is enabled or not. You can also set whether the Private 
Print Restriction function and Hold Print Restriction function are enabled or not. The [Account Settings] dialog box 
appears upon clicking this button.

 P.54 “Account Settings”

6) [Version Information]
Click this button to display the [Version Information] dialog box.

7) [Restore Defaults]
Click this button to restore the configuration of this equipment displayed in the [Configuration] tab menu to the original 
factory defaults.
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Drawer Settings

1) Paper Size
Select the paper size set in each drawer.

2) Paper Type
Select the paper type set in each drawer.

3) Attribute
Select the attribute of the paper. When you set the attribute, the drawer will be selected preferentially according to the 
print settings.

4) Override Application Paper Source Settings
Select this check box to use the paper source setting in the printer driver rather than the application setting.

5) [Restore Defaults]
Click this button to restore the settings displayed in the [Drawer Settings] dialog box to the original factory defaults.
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Account Settings

When SNMP communication is enabled, the following account information is automatically obtained from the 
equipment.

1) Use User Authentication
Select this check box to enable the user management function.

2) User Name
The user name that is entered to log in to your computer is displayed.

3) Domain Name
The domain name on which the equipment belongs is displayed.

4) Private Print Restriction
Select this check box to enable the Private Print Restriction function.

5) Hold Print Restriction
Select this check box to enable the Hold Print Restriction function.

For details on the Private Print Restriction function and Hold Print Restriction function, call your service technician.
After you adjust settings in the [Account Settings] dialog box, make sure to confirm that the settings have been 
changed as specified in the printing preferences dialog box, accessing from the [File] menu > [Printing 
Preferences]. You can also confirm that the settings have been changed as specified on the properties page of the 
printer driver when you print documents from applications.
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In this section, procedures are given to print various types of print jobs, using the layout and finishing options. Read this 
section before starting printing and select a procedure best suited for your needs.

 P.55 “Printing various print job types”
 P.62 “Layout and finishing options in the [Basic] tab menu”
 P.63 “Layout and finishing options in [Finishing] tab menu”
 P.70 “Finishing options in the [Paper Handling] tab menu”
 P.72 “Finishing options in the [Effect] tab menu”
 P.76 “Using various types of paper”

Printing various print job types
The printer drivers provide various ways to handle such jobs as Scheduled Print, Private Print, Hold Print, Proof Print, 
Overlay Image file, and Store to e-Filing.

 P.55 “Printing Scheduled Print jobs”
 P.56 “Printing Private Print jobs”
 P.57 “Printing Hold Print jobs”
 P.58 “Printing Proof Print jobs”
 P.59 “Creating an overlay file”
 P.60 “Storing to e-Filing”

Printing Scheduled Print jobs
The Print Scheduling feature allows you to specify the date and time to print your job. This feature is especially useful for 
delaying your print job until the off-peak hours.

The time of the System and MFP should be the same.

Printing on a specified date and time

1 Display the [Basic] tab menu.

2 Select [Scheduled Print] in the [Print Job] box.

3 Click [...].
The [Scheduled Time] dialog box appears.

4 Click the arrow button at the [Date] box to display the Calendar window, and select the 
desired date for your print job.
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5 Select the [Time] box and click the spin button to change the time.

To change the hour, select the hour number and click the spin button.
To change the minute, select the minute number and click the spin button.

6 Click [OK].
The specified date and time are displayed in each box.

7 Set any other print options as required and click [OK].

8 Click [OK] or [Print] to send the print job.
The document will be queued to print at the specified time and date.

Printing Private Print jobs
When you want to print private documents, use this feature.

The Private Print function can be used when the user management setting is disabled on the equipment.

Printing confidential documents

1 Display the [Basic] tab menu.

2 Select [Private Print] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.

5 Enter a password in the [Password] box and click [OK].

The print job is stored in the Private Print job list in the touch panel display.

Enter a password using alphanumeric characters and symbol characters (ASCII code characters between 
0x21 to 0x7E) in the [Password] box. The password must be between 1 and 63 characters.
When you enter this password on the touch panel display, the confidential documents will be printed. If you 
forget it, you will not be able to print them.

6 Press the [PRINT] button on the control panel.

7 Press [PRIVATE] on the touch panel.
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8 Select the desired user name and press [PASSWORD]. 

When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the 
equipment, its nickname will be displayed on the Private Print job list. If not, the user name that is entered to log 
in to your computer will be displayed on the Private Print job list.

9 Enter the password for the Private Print job, which has previously been set via the 
computer, and then press [OK].

When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Private Print jobs for which the same password has been set.
When the nickname is entered for [User name (Alias)]:
The displayed list contains the Private Print jobs for which the same nickname and the same password have 
been set.

10 Select the desired job on the Private Print job list and press [PRINT].
For the detailed instructions on how to use the control panel, see the following page:

 P.135 “Private Print jobs”

Printing Hold Print jobs
When you want to print Hold Print documents, use this feature.

Printing Hold Print documents

1 Display the [Basic] tab menu.

2 Select [Hold Print] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is stored in the Hold Print job list in the touch panel display.

5 Press the [PRINT] button on the control panel.

6 Press [HOLD] on the touch panel.

7 Select the desired user name.

When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the job to the 
equipment, its nickname will be displayed on the Hold Print job list. If not, the user name that is entered to log in 
to your computer will be displayed on the Hold Print job list.

8 Select the desired job on the Hold Print job list and press [PRINT].
For the detailed instructions on how to use the control panel, see the following page:

 P.139 “Hold Print jobs”

When the user name that is entered to log in to your computer is used for [User name (Alias)]:
The displayed list contains the Hold Print jobs which have been registered by the selected user.
When the nickname is entered for [User name (Alias)]:
The displayed list contains all the Hold Print jobs which have been registered by users having the same 
nickname.
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Printing Proof Print jobs
You can print out one proof copy as a trial first. This feature helps to prevent wasting paper. After viewing the first copy, 
you can decide whether to print out the remaining copies or cancel the job.

When you want to print multiple copies, each of which is to be sent as an individual print job by your application, all the 
copies, not just one copy, will be printed even if you set Proof Print. In such a case, print just one trial copy first, and 
then specify the required number of copies on the touch panel display.

Printing a proof copy

1 Display the [Basic] tab menu.

2 Select [Proof Print] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
One copy of the document is printed and the print job is stored in the Proof Job list in the touch panel display.

5 Press the [PRINT] button on the control panel. 

6 Press [PROOF] on the touch panel.
The Proof Print job list is displayed.

7 Select the desired job on the Proof Print job list and press [PRINT].
For the detailed instructions on how to use the control panel, see the following page:

 P.132 “Proof Print jobs”
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Creating an overlay file
You can save up to 20 documents as overlay files using the printer driver. You can print an overlay on the foreground or 
background of a document. To do that, you must first create an overlay file.

 P.74 “Printing with an overlay file”

If you save a multi-page document as an overlay file, only the first page of the document will be saved as an 
overlay file.
Both the overlay file and the documents on which you superimpose the overlay image must be created at the same 
size and orientation.
When creating an overlay file using the PS3 printer driver from an application that can create the PS command 
directly, the overlay file will not be created properly. In that case, disable the [Use PostScript Passthrough] option in 
the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

Printing a document as an overlay file

1 Display the [Basic] tab menu.

2 Select [Print to Overlay File] in the [Print Job] box.

3 Click [...].
The [Overlay Image Name] dialog box appears.

4 Enter an overlay image name and then click [OK].

You can enter up to 63 characters.

5 Set any other print options as required and click [OK].

6 Click [OK] or [Print] to send the print job.
The document is saved as an overlay file.

You can use a created overlay file when you want to print a document.
 P.74 “Printing with an overlay file”
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Storing to e-Filing
The Store to e-Filing feature allows you to send print jobs to e-Filing on this equipment. The job stored to e-Filing can then 
be printed from the touch panel display at a later time. It can also be composed with other documents using the e-Filing 
web utility.
You can select either a [public] or [user] box to store print jobs. You can also specify a folder in which the print job is to be 
stored in these boxes. The public box is shared by all users who can see the jobs stored in this box. User boxes are boxes 
that users can create as desired. Access to user boxes can be restricted with a password.

When you store a document in e-Filing using the printer driver, the printing image (not the original document in your 
computer) will be stored in e-Filing.
Documents stored in e-Filing are retained in the best image quality for printing. If you want to download them into 
your computer in a higher image quality, scan the original documents and store them in e-Filing.

You can manage the files within a box from the touch panel display. Refer to the e-Filing Guide to manage files in 
a box.
You can also manage the files within a box using the e-Filing web utility. Refer to the e-Filing Guide.

Saving a print job to a public box

1 Display the [Basic] tab menu.

2 Select [Store to e-Filing] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Select [Public Box].

5 When you specify a folder in which the print job is to be stored in a public box, enter 
the folder name in the [Box Folder] box.

If the entered folder name is not found, a new folder is created under this folder name.
Enter the folder name within 64 characters.
Once there are 100 folders, you cannot create a new folder.
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6 If you print the job as well as saving to the public box, select the [Print] check box.

7 Click [OK].

8 Click [OK] or [Print] to send the print job.
The print job is saved to the public box.

Saving a print job to a user box

1 Display the [Basic] tab menu.

2 Select [Store to e-Filing] in the [Print Job] box.

3 Set any other print options as required and click [OK].

4 Select a user box in the [Store to] box to save a print job and enter the 5-digit password 
for the user box in the [Password] box if required.

5 When you specify a folder in which the print job is to be stored in a user box, enter the 
folder name in the [Box Folder] box.

If the entered folder name is not found, a new folder is created under this folder name.
Enter the folder name within 64 characters.
Once there are 100 folders, you cannot create a new folder.

6 If you print the job as well as saving to a box, select the [Print] check box.

7 Click [OK].

8 Click [OK] or [Print] to send the print job.
The print job is saved to the specified user box.
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Layout and finishing options in the [Basic] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section, various printing 
functions enabled with the [Basic] tab menu are explained.

 P.62 “Fitting images within paper size”

Fitting images within paper size
You can automatically enlarge or reduce a document image to fit a specified paper size, or manually set the scale to 
enlarge or reduce the image.

Printing an enlarged or reduced image to fit the specified paper size

1 Display the [Basic] tab menu.

2 Select the document size in the [Original Paper Size] box. Then select the paper size 
that you want to print in the [Print Paper Size] box.

The document image is automatically enlarged or reduced depending on the original paper size and print paper 
size.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
The enlarged or reduced image is printed to fit the specified paper size.

Printing an enlarged or reduced image by specifying the scale manually

1 Display the [Basic] tab menu.

2 Select the [Manual Scale] check box. Then enter the scale.

The scale can be set from 25% to 400% in units of 1%.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
An enlarged or reduced image is printed by the specified scale.
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Layout and finishing options in [Finishing] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section, various printing 
functions enabled with the [Finishing] tab menu are explained.

 P.63 “Sort printing”
 P.64 “Printing on both sides of a sheet”
 P.65 “Making a booklet”
 P.67 “Printing several pages on one sheet”
 P.68 “Stapling”
 P.69 “Hole punching”

Sort printing
You can select how multiple copies of a document are to be output, such as separately for each copy, grouping each page, 
and alternating the paper direction for each copy.

Sorting printed documents according to copy

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed in the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select the [Sort Copies] icon under [Copy Handling].

5 Set any other print options as required and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to copy.

Sorting printed documents according to page

If, for example, you have a three-page job (A, B, C) and you want three copies of each page in this order (AAA, BBB, 
CCC), you can use this function.

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select the [Group Copies] icon under [Copy Handling].

5 Set any other print options as required and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are sorted according to page.
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Sorting printed documents horizontally and vertically for each copy

The rotate sort mode can be enabled only when printing on Letter, A4, B5, or 16K.

1 Display the [Basic] tab menu.

2 Enter the number of copies to be printed at the [Number of Copies] box.

3 Display the [Finishing] tab menu.

4 Select the [Rotated Sort] icon under [Copy Handling].

5 Set any other print options as required and click [OK].

6 Click [OK] or [Print] to send the print job.
The printed documents are alternately sorted horizontally and vertically for each copy.

Printing on both sides of a sheet
You can print on both sides of the paper.

Printing on both sides of paper

1 Display the [Finishing] tab menu.

2 Select the [2-Sided Printing] check box and select the direction to be printed.

You can also set booklet printing at the [2-Sided Printing] option by selecting the [Booklet] icon. For the 
instructions on how to perform booklet printing, see the following section.

 P.65 “Making a booklet”

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
The print job is printed on both sides of the paper in the specified direction.

Book — Select this option to print on both sides of the paper in a vertical direction, so the pages can be 
bound and turned over right and left.

Tablet — Select this option to print on both sides of the paper in a vertical reversal motion, so the pages 
can be bound and turned over up and down.
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Making a booklet
Printing in normal booklet mode produces a document that, when folded, becomes a properly paginated booklet or 
magazine-style publication. You can even create bound booklets that are folded and stapled in the center.
For example, if you create a document on letter-size paper (8½ x 11 inches) and then print in booklet mode, the yield is a 
5½-x-8½- inch booklet. Each page has been scaled to fit on half a sheet and reordered so that the booklet is properly 
paginated when folded.
To retain your original document size when printing booklets, select the booklet size to be the same as your original 
document size. Then, your 8½- inch document is printed on ledger size paper (11 x 17 inches) and reordered so that, 
when folded, the yield is an 8½-x-11-inch booklet. You can select from the following page-size options when printing a tiled 
booklet:

Letter Booklet on Ledger
A4 Booklet on A3
B5 Booklet on B4

When Booklet printing is performed using the PS3 printer driver from an application that can create the PS command 
directly, the booklet will not be printed appropriately. In that case, disable the [Use PostScript Passthrough] option in 
the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

Creating a booklet

1 Display the [Finishing] tab menu.

2 Select the [2-Sided Printing] check box and select the [Booklet] icon.

3 Click [Details].
The [Booklet Details] dialog box appears.

4 Select the booklet size in the [Output Document Layout] box.
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Letter-Half on Letter — Select this option to print a 1/2 Letter size booklet. Every 2 pages are printed on Letter 
paper to fit on half a sheet.
LT on LD — Select this option to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit on half 
a sheet (Letter).
1/2 LG on LG — Select this option to print a 1/2 Legal size booklet. Every 2 pages are printed on Legal paper to fit 
on half a sheet.
1/2 Statement on Statement — Select this option to print a 1/2 Statement size booklet. Every 2 pages are printed 
on Statement paper to fit on half a sheet.
1/2 Comp on Comp — Select this option to print a 1/2 Computer size booklet. Every 2 pages are printed on 
Computer paper to fit on half a sheet.
1/2 13LG on 13LG — Select this option to print a 1/2 13 inch LG size booklet. Every 2 pages are printed on 13 inch 
LG paper to fit on half a sheet.
1/2 8.5SQ on 8.5SQ — Select this option to print a 1/2 8.5 inch SQ size booklet. Every 2 pages are printed on 8.5 
inch SQ paper to fit on half a sheet.
A5 on A4 — Select this option to print an A5 size booklet. Every 2 pages are printed on A4 paper to fit on half a 
sheet (A5).
A4 on A3 — Select this option to print an A4 size booklet. Every 2 pages are printed on A3 paper to fit on half a 
sheet (A4).
B5 on B4 — Select this option to print a B5 size booklet. Every 2 pages are printed on B4 paper to fit on half a 
sheet (B5).
B6 on B5 — Select this option to print a B6 size booklet. Every 2 pages are printed on B5 paper to fit on half a 
sheet (B6).
1/2 Folio on Folio — Select this option to print a 1/2 Folio size booklet. Every 2 pages are printed on Folio paper to 
fit on half a sheet.
A6 on A5 — Select this option to print an A6 size booklet. Every 2 pages are printed on A5 paper to fit on half a 
sheet (A6).
32K on 16K — Select this option to print a 32K size booklet. Every 2 pages are printed on 16K paper to fit on half 
a sheet.
16K on 8K — Select this option to print a 16K size booklet. Every 2 pages are printed on 8K paper to fit on half a 
sheet.

5 Select the page order for the booklet in the [Page Order] option.
From Left to Right — Select this option to print the pages from left to right.
From Right to Left — Select this option to print the pages from right to left.

6 If you want to add a margin space between facing pages, enter a width in the [Center] 
box, and if you want to add a margin on the outside edge, enter a width in the [Outer] 
box.

You can change the unit of the margin in [Units].
The center margin can be set from 0.00 inches to 0.50 inches in units of 0.01 inches when the unit is inches, 
and from 0.00 mm to 12.70 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.
The outer margin can be set from 0.00 inches to 1.00 inches in units of 0.01 inches when the unit is inches, and 
from 0.00 mm to 25.40 mm in units of 0.10 mm when the unit is mm.
The printed images will be reduced according to the margin setting.

7 If you want to double staple the center, select the [Staple Down the Center] check box.

[Staple Down the Center] is available only when the Saddle Stitch Finisher (optional) is installed and configured 
in the [Configuration] tab.

8 Click [OK] to close the [Booklet Details] dialog box.

9 Set any other print options as required and click [OK].

10 Click [OK] or [Print] to send the print job.
The print job is printed as a booklet.

If the Saddle Stitch Finisher (optional) is not installed, the output will not be folded. But you can create a booklet 
by manually folding along the center.
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Printing several pages on one sheet
The N-up feature allows you to print several pages of a document on one sheet of paper. This feature is very useful for 
browsing a large number of pages for appearance or page order.
For example, to check the navigation path of a number of web pages or review the narrative of a slide presentation, using 
N-up is not only convenient but conserves paper as well.

If you are using the Image Overlay feature in combination with N-up printing, the overlay prints once per sheet, 
rather than once per page.
When N-up printing is performed using the PS3 printer driver from an application that can create the PS command 
directly, the print function will not work appropriately. In that case, disable the [Use PostScript Passthrough] option 
in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

Printing multiple pages per sheet

1 Display the [Finishing] tab menu.

2 Select how many pages you want to print on a single sheet at the [Number of pages per 
Sheet] box.

3 Select how the pages are arranged on one sheet in the [Direction of Print] option.

Left to Right — Select this option to arrange pages horizontally from the left and printed top to bottom on one 
sheet.
Right to Left — Select this option to arrange pages horizontally from the right and printed top to bottom on one 
sheet.
Left to Right by column — Select this option to arrange pages vertically from the top and printed left to right on 
one sheet.
Right to Left by column — Select this option to arrange pages vertically from the top and printed right to left on 
one sheet.

4 If you want to draw a line around each page, select the [Draw Borders Around Pages] 
check box.

5 Set any other print options as required and click [OK].

6 Click [OK] or [Print] to send the print job.
Multiple pages are printed per sheet.

2 pages — Select this option to print images from 2 pages arranged on one sheet.

4 pages — Select this option to print images from 4 pages arranged on one sheet.

6 pages — Select this option to print images from 6 pages arranged on one sheet.

8 pages — Select this option to print images from 8 pages arranged on one sheet.

9 pages — Select this option to print images from 9 pages arranged on one sheet.

16 pages — Select this option to print images from 16 pages arranged on one sheet.
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Stapling
You can staple sets of paper.

Stapling is not available if a Finisher (optional) is not installed.

Stapling the paper

1 Display the [Finishing] tab menu.

2 Select the [Staple] check box. Select a stapling option.

The selectable options vary depending on the paper size.
[Center Double] can be selected only when the Saddle Stitch Finisher (optional) is installed and configured 
in the [Configuration] tab.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
The output is stapled for each copy as specified.

Upper Left — Select this option to staple the printed document at the upper left.

Upper Right — Select this option to staple the printed document at the upper right.

Center Top — Select this option to double staple the printed document along the top edge.

Middle Left — Select this option to double staple the printed document along the left side.

Center Double — Select this option to fold and double staple the printed document in the center.
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Hole punching
Select this function to punch holes in printed sheets of paper.

Hole punching is not available if a Hole Punch Unit (optional) is not installed.

Punching holes

1 Display the [Finishing] tab menu.

2 Select the [Hole Punch] check box. Select a hole punch option.

3 Set any other print options as required and click [OK].

4 Click [OK] or [Print] to send the print job.
Holes are punched in the print job as specified.

Center Top — Select this option to punch holes along the top edge.

Middle Left — Select this option to punch holes along the left side.
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Finishing options in the [Paper Handling] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section, various printing 
functions enabled with the [Paper Handling] tab menu are explained.

 P.70 “Inserting different types of paper”
 P.71 “Interleaving pages”

Inserting different types of paper
You can insert a different type of sheet into a specified location in the printed documents. This feature is useful when you 
want to add front and back covers, or sheets between chapters. Both printed and blank sheets can be inserted.

Printing or inserting a front cover and back cover

1 Display the [Paper Handling] tab menu.

2 To print or insert a front cover, select the [Use Front Cover] check box and select the 
drawer where the cover paper is loaded in the [Source] box. Then select whether 
inserting a blank cover or printed front cover in the [Print Style] box.

Do not print on page — Select this option to insert a blank front cover.
Print one side of the page — Select this option to print the first page of the document on the front side of a cover.
Print both sides of page — Select this option to print the first two pages of the document on both sides of a cover.

When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed 
document size.
[Print both sides of page] is available only when 2-Sided printing is enabled in the [Finishing] tab.

3 To print or insert a back cover, select the [Use Back Cover] check box and set the 
[Source] and [Print Style] options as required.

How to set the Source and Print Style options is the same as for the [Use Front Cover] option.

4 To print or insert sheets between the pages, select the [Insert Pages] check box and 
click [Edit].

The [Insert Pages] dialog box appears.

Up to 50 pages can be inserted.
When Insert Pages printing is performed using the PS3 printer driver from an application that can create the 
PS command directly, the interleaving sheets may not be inserted between the designated pages. In that 
case, disable the [Use PostScript Passthrough] option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”
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5 Enter the page numbers at which you want to insert the sheet in each [Page] box and 
select the [Print Style], [Paper Source], and [Paper Type] options as required.

6 Set any other print options as required and click [OK].

7 Click [OK] or [Print] to send the print job.
A front cover and back cover are inserted into the printed document.

Interleaving pages
This feature is useful when you want to insert a different type of paper, or from another source, between every page of 
your print job. For example, you could use this option to insert blank or color sheets between overhead transparencies.

Inserting sheets between every page of a print job

1 Display the [Paper Handling] tab menu.

2 To insert sheets between every page, select the [Interleave Pages] check box and 
select the drawer where the desired paper is loaded in the [Source] box.

When [Auto] is selected in the [Source] box, the paper is automatically selected according to the printed 
document size.

3 To print the previous page on interleaved sheets, select the [Duplicate] check box.
This equipment prints every previous page on interleaved sheets which are inserted after the page so that you can 
duplicate a document.

4 Set any other print options as required and click [OK].

5 Click [OK] or [Print] to send the print job.
The sheets are interleaved between every page.
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Finishing options in the [Effect] tab menu
Using the printer driver, you can set various layout options to suit your preferences. In this section, various printing 
functions enabled with the [Effect] tab menu are explained.

 P.72 “Printing with watermarks”
 P.74 “Printing with an overlay file”

Printing with watermarks
A watermark such as [TOP SECRET], [CONFIDENTIAL], [DRAFT], [ORIGINAL], or [COPY] can be printed over a 
document. You can choose from several predefined watermarks or you can create and save your own custom 
watermarks.
Watermarks are text only. To add graphics or other document elements, use image overlays instead.

Printing a watermark

1 Display the [Effect] tab menu.

2 Select the watermark to be printed at the [Watermark] box.

You can create a new watermark if there is none you want to apply on the box.

3 If you want to print the watermark only on the first page, select the [Print on First Page 
Only] check box.

4 Set any other print options you require and click [OK].

5 Click [OK] or [Print] to send the print job.
The print job is printed with the watermark.
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Creating or editing a watermark

1 Click [Add] to create a new watermark, or select a watermark that you want to edit and 
click [Edit] to edit the watermark.

The [Watermark] dialog box appears.

2 Adjust the position of the watermark by specifying X and Y values in [Position].
If you click [Center Watermark], the watermark is placed at the center of the page.

3 Enter the watermark text in the [Caption] box.
You can enter up to 63 characters for the [Caption] box. However, if too many characters are entered, the 
watermark may not be printed correctly.

4 Select a font for the watermark in the [Font Name] box.

5 Select a font style for the watermark in the [Style] box.

6 Enter the font size in the [Font Size] box.
You can enter any integer between 6 and 300pt in units of 1pt.

7 To rotate the watermark, enter the number of degrees in the [Angle] box.
You can enter from -90 degrees to 90 degrees in units of 1 degree in the [Angle] box.
You can also set the angle using the scroll bar.

8 Select how the watermark text is printed from [Solid], [Draw as Outline], and 
[Transparency].
Solid — Select this option to print a solid type of watermark.
Draw as Outline — Select this option to print an outline type of watermark.
Transparency — Select this option for a transparent watermark. Set the transparent ratio from 0 to 100% in units 
of 1%. You can also set the transparent ratio using the scroll bar.

9 Click [OK] to save the watermark settings.
The watermark settings are now saved.
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Deleting a watermark

You can delete the default watermarks. However, they cannot be restored by clicking [Restore Defaults].

1 Select the watermark that you want to delete at the [Watermark] box.

2 Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].

The watermark is deleted.

Printing with an overlay file
Using image overlays ensures that widely-used images are readily available and consistently reproduced. Image overlays 
are independent documents that are merged into other documents during printing and thereby increase the time required 
to print a job. To superimpose text on your document, it may be faster to use watermarks.
To print with an overlay file, you must first create an overlay file.

 P.59 “Creating an overlay file”

If you use Image Overlays in combination with the N-up feature, the image overlay is printed once per sheet, not 
once per page.
Both the overlay file and the documents on which you superimpose the overlay image must be created at the same 
size and orientation.
When printing with Overlay Image using the PS3 printer driver from an application that can create the PS 
command directly, the overlay image will not be printed. In that case, disable the [Use PostScript Passthrough] 
option in the [PostScript Settings] dialog box.

 P.48 “PostScript Settings”

Printing an overlay image as a print job

1 Display the [Effect] tab menu.

2 Select the overlay image name to be used in the [Overlay Image] box.

3 If you want to print the overlay image over the document, select the [Print Over the 
Document] check box.
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4 Set any other print options as required and click [OK].

5 Click [OK] or [Print] to send the print job.
The print job is printed with the overlay image.

Deleting an overlay image

1 Select an overlay image that you want to delete at the [Overlay Image] box.

2 Click [Delete].
The [Confirm Delete] dialog box appears.

3 Click [Yes].

The overlay image is deleted.
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Using various types of paper
This equipment allows you to print on various types of paper. The procedure below is for print jobs which require 
precautions before placing paper.

 P.76 “Printing on tab paper”
 P.78 “Printing on paper larger than standard sizes”

Printing on tab paper
This equipment supports tab printing, which can print in the tab extension of the tab paper. The job will be output in the exit 
tray.

This equipment can print only on the Letter sized or A4 sized tab paper.
If the document for tab printing is not created properly or the Image Shift Width is not set properly, the image will not 
be printed in the correct position within the tab extension. Make sure to create the document and set the Image 
Shift Width correctly.
If mis-printing occurs while multiple tab pages are printed continuously, toner may adhere to the reverse side of 
paper. To avoid this, it is recommended to print tab paper as a separate job for each page so that this equipment 
performs cleaning before printing the next tab paper.
When printing the tab paper, it may be caught in the exit in the exit tray because the roller to deliver the tab 
extension does not exist. In this case, remove the tab paper before printing the next job.

Printing a document on tab paper

1 Create a Letter sized or A4 sized document and place the text or object that should 
appear on the tab extension as described below.

When you create a document for tab printing, place the text or object that should appear on the tab extension on 
the right side of the document. You must place the text in the height that exactly fits the tab extension.

The margin between the shifted text and right edge of the tab extension must have at least 0.08 inches or 2.0 
mm of space because any information in this margin is not printed.

2 Place the tab paper on the Bypass Tray.
When you place the tab paper on the Bypass Tray, make sure the tab side of the paper is facing outward.
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3 When printing a document, display the [Basic] tab menu of the printer driver 
properties, select document size in the [Original Paper Size] box, and select either 
[Letter Tab] or [A4 Tab] (according to the document size) in the [Print Paper Size] box.

The [Primary Tab Dialog] dialog box appears.

4 In the [Tab Manufacturer] box, select the product name of the tab paper that you use, or 
select [Custom] when you use other manufactured tab paper.

5 When you select [Custom] in the [Tab Manufacturer] box, enter the width of the tab 
extension in the [Tab Extension] box.

6 Enter the width to shift the printed image in the [Image Shift Width] box.

The 0.08 inches or 2.0 mm margin on the right side of the paper is not a printable area. Therefore, be sure to 
enter the image shift margin so that an image will be printed within the printable area.

7 Click [OK].

8 Set any other print options as required and click [OK].

9 Click [OK] or [Print] to send the print job.

10 Press [JOB STATUS] on the touch panel.
The print job list appears.

11 Select the desired job in the print job list and then press the [START] button on the 
control panel.

The print job is printed on the tab paper.
For the detailed instructions on how to use the control panel, see the following page:

 P.128 “Monitoring the Print Job Status”
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Printing on paper larger than standard sizes
The procedure below is for printing on paper larger than standard sizes defined in the custom paper size setting. (Largest 
size: 11.70 x 17 inches (297 x 432 mm)) 
Custom paper sizes can be defined in the [Other] tab menu.

 P.47 “Custom Paper Size”

Printing on paper larger than standard sizes

1 Display the properties of the printer driver and select the custom paper size in [Print 
Paper Size] of the [Basic] tab menu before starting printing.

2 Set any other print options as required and click [OK].

3 Click [OK] or [Print] to send the print job.

4 Place paper larger than the standard sizes on the bypass tray.

Do not mix with other sizes.
Print sheets one by one from the bypass tray even if you have set the number of copies more than one.

5 Press [JOB STATUS] on the touch panel.
The print job list appears.

6 Select the desired job in the print job list and then press the [START] button on the 
control panel.

The print job is printed on paper larger than the standard sizes.
For the detailed instructions on how to use the control panel, see the following page:

 P.128 “Monitoring the Print Job Status”
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This chapter provides the instructions on how to print from a Macintosh computer.
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Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.5.x

Once you have installed the PPD file as described in “Installing the Printer on Mac OS X 10.2.4 to Mac OS X 10.5.x” of the 
Software Installation Guide, you can print directly from most of the Mac OS X applications.

Considerations and limitations
If you print a PDF file with the “Preview” application on Mac OS X 10.2.x, the page order will be incorrect. Use Adobe 
Reader.
The Cover Pages option of the Printer Features menu is available for Mac OS X 10.3.x or later.
The Cover Pages option of the Printer Features menu and the booklet printing cannot be used at the same time.
The Cover Pages option of the Printer Features menu and the N-up printing (multiple pages per sheet) cannot be used 
at the same time.
The Cover Pages option of the Printer Features menu and the Cover Page option for sending a print job with a banner 
page cannot be used at the same time.
To perform proof printing, private printing or scheduled printing on Mac OS X 10.5.x, use LPR, AppleTalk or Bonjour.
To use the user authentication function, adjust the domain settings on [Applications] > [Utilities] > [Directory Access] > 
[BSD Flat and NIS].
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How to print from Mac OS X 10.2.4 to Mac OS X 10.5.x
You do not need to switch printers before starting printing because they are all managed under the setting of [Print & Fax] 
of [System Preferences]. Once a printer is added to the Printer List, you can select any printer directly from the [Page 
Setup] dialog box or the [Print] dialog box.

Setting options and printing from Macintosh computers
In Mac OS X applications, print options are set from both the [Page Setup] dialog box and the [Print] dialog box.

The [Page Setup] dialog box varies depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog boxes.

Printing from Macintosh applications

1 Open a file and select [Page Setup] from the [File] menu of the application.

2 Select the name of the equipment at the [Format for] box and specify the Page Setup 
settings for your print job.

Setting the Page Setup varies depending on how you want to print a document.
 P.83 “Page Attributes”

3 Click [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the application.

5 In the dialog box that appears, make sure the name of the equipment is selected at the 
[Printer] box and specify the Print settings for your print job.

Setting the Print Setup varies depending on how you want to print a document.
 P.88 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.5.x”
 P.102 “Print dialog on Mac OS X 10.2.x”

The [Print] dialog box varies depending on applications.
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6 Click [Print] to print a document.

The content set in the [Print] dialog box can be saved as [Presets]. Select [Save as] in the [Presets] box and 
save it under the desired name. If you use this preset content as the default setting, select it in the [Presets] 
box.
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Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.5.x
The [Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the [File] menu of the 
application.
In the [Page Setup] dialog boxes, you can specify the Page Attributes settings and manage the Custom Page Size 
settings.

The [Page Setup] dialog box varies depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog boxes.

Page Attributes

1) Format for
This option selects the printer to be used for printing.

2) Paper Size
This option selects the size of a document to be printed.

The default paper size is [US Letter] for the United States, and [A4] for the other countries.

3) Orientation
This option sets the paper printing direction.
- Portrait — The document is printed in the portrait direction.
- Landscape (90 degree) — The document is printed in the landscape direction from left.
- Landscape (270 degree) — The document is printed in the landscape direction from right. This is selectable only 

for Mac OS X 10.2.x to Mac OS X 10.4.x.

4) Scale
This option changes the size of the printed image on the page. Enter the zoom ratio to enlarge or reduce an image. 
You can set any integer from 1 to 10000 (%) for the zoom ratio. For Mac OS X 10.2.4 to Mac OS X 10.4.x, the 
acceptable range for the zoom ratio is from 25% to 400%.

Available original paper sizes are listed below:

A3
A4
A5
A6
JB4
JB5
Ledger
US Legal

US Letter
Statement (5 1/2 x 8 1/2”)
Folio
Computer (10 1/8 x 14”)
13”LG (8 1/2 x 13”)
8.5”SQ (8 1/2 x 8 1/2”)
8K (270 x 390 mm)
16K (195 x 270 mm)

1

2

3

4
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Custom Page Sizes
The PPD file for this equipment supports the Custom Page Sizes.
The procedure to create the Custom Page Size varies between the Mac OS X 10.4.x to Mac OS X 10.5.x and Mac OS X 
10.2.8 to Mac OS X 10.3.x.

When you print on paper larger than standard sizes, print them one by one.

Creating Custom Page Size on Mac OS X 10.4.x to Mac OS X 10.5.x

1 Select [Manage Custom Sizes] in the [Paper Size] box.

The [Custom Page Sizes] dialog box appears.

2 Click [+].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].

3 Double-click the added custom page size name on the list and rename the custom page 
size.
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4 Enter the width and height in the [Page Size] boxes, and select the printer name of this 
equipment in the [Printer Margins] box.

Use the margin settings that are automatically entered by selecting the printer name in the [Printer Margins] 
box.
You can delete the created custom page size by clicking [-].

5 Click [OK].
The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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Creating Custom Page Size on Mac OS X 10.2.8 to Mac OS X 10.3.x

1 Select [Custom Paper Size] in the [Settings] box.

The Custom Paper Size menu is displayed.

2 Click [New].

A new custom page size name is added to the list.

If you want to create a new custom page size by duplicating an existing custom page size, select the custom 
page size name on the list and click [Duplicate].

3 Rename the custom page size.
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4 Enter the width and height in the [Page Size] boxes, and enter the printer margins in the 
[Printer Margins] boxes.

In the [Printer Margins] box, enter “0.17” inches.
You can delete the created custom page size by clicking [Delete].

5 Click [Save] and click [OK].

The Custom Page Size is saved and it can be selected in the [Paper Size] box in the Page Attributes menu.
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Print dialog on Mac OS X 10.3.x to Mac OS X 10.5.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.5.x. See the 
following section for the descriptions of the [Print] dialog boxes for Mac OS X 10.2.x.

 P.102 “Print dialog on Mac OS X 10.2.x”

The [Page Setup] dialog boxes vary depending on applications. In some applications, it is not included in the [File] 
menu, but in the [Print] dialog box.

Copies & Pages
In the Copies & Pages menu, you can set general print options such as the number of copies, and sort printing.
The following screenshot is the Copies & Pages menu accessed from Microsoft Word.

1) Preview window
The print preview is displayed.

2) Show Quick Preview
Select this check box to enable the preview feature.

3) [Page Setup]
Click this button to display the [Page Setup] dialog box.

4) Copies
This option sets the number of printed copies.

5) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

6) Pages
This option sets the range of pages to be printed.
- All — Select this option to print all pages.
- Current page — Select this option to print the page currently selected.
- Selection — Select this option to print only texts and objects selected on the page.
- From/to — Select this option to specify the pages to be printed. Enter the page range in the [From] and [to] boxes.
- Page range — Select this option to specify individual pages and/or page ranges to be printed. Enter page numbers 

and/or page ranges in the box.
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Layout
In the Layout menu, you can set N-up printing (multiple pages per sheet).

1) Pages per Sheet
This option sets the number of multiple pages printed on one sheet. The pages are reduced to fit the selected paper 
size automatically and are printed.
- 1 — Select this option if you do not wish to enable N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-up printing (printing 
multiple pages on one sheet) is enabled.

3) Border
Select this option if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single Hairline — Select this option to draw a single hairline for the border.
- Single Thin Line — Select this option to draw a single thin line for the border.
- Double Hairline — Select this option to draw a double hairline for the border.
- Double Thin Line — Select this option to draw a double thin line for the border.

4) Two-Sided
This option sets whether or not you want to print on both sides of the paper.
- Off — Select this option when you do not want to print on both sides of the paper.
- Long-edge binding — Select this option to bind along the long edge side of the paper. The direction to be printed 

on the back side of the paper differs depending on the orientation.

Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom 
on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom 
on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bottom and then left to right on 
one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bottom and then right to left on 
one sheet.

1
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- Short-edge binding — Select this option to bind along the short edge side of the paper. The direction to be printed 
on the back side of the paper differs depending on the orientation.

Output Options
In the Output Options menu, you can save a print job as a file.

This menu is displayed only for Mac OS X 10.3.x.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type in the [Format] box.

2) Format
This option sets the format of a file to be saved.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.

Scheduler
In the Scheduler menu, you can set when a print job will be sent to the equipment.

1) Print Document
This option sets when a print job will be sent to the equipment.
- Now — Select this option to send a print job now.
- At — Select this option to specify the time to send a print job. Set the time to send the print job. The print job will be 

held in the queue on Mac OS X until the specified time or until you resume the print job to be sent from the queue 
on Mac OS X.

- On Hold — Select this option to hold a print job in the queue on Mac OS X. When you select this, the print job will 
be held in the queue on Mac OS X until you resume the print job to be sent from the queue on Mac OS X.

2) Priority
Select the priority of a print job.
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Paper Handling
In the Paper Handling menu, you can set Reverse page order printing and Odd or Even numbered page printing.
The screens in the Paper Handling menu vary between Mac OS X 10.3.x and Mac OS X 10.4.x.

Mac OS X 10.3.x

1) Reverse page order
Select this check box when you want to print a document beginning with the last page.

2) Print
Select whether all pages will be printed or only odd or even pages will be printed.

Mac OS X 10.4.x

1) Page Order
Select the page order for printing.

2) Print
Select whether to print all pages or only odd/even pages.

3) Destination Paper Size
Select the output paper size.
- Use documents paper size — Select this option to print on the same sized paper as the document size.
- Scale to fit paper size — Select this option to perform enlarge/reduce printing. Select the output paper size in the 

box. If you do not want to enlarge the document images when a larger paper size is selected, select the [Scale 
down only] check box.
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Mac OS X 10.5.x

1) Page To Print
Select whether all pages will be printed or only odd or even pages will be printed.

2) Destination Paper Size
Select the output paper size. The paper size selected in the [Page Setup] dialog box appears as the default setting.
- Scale to fit paper size — Select this check box to perform enlarge/reduce printing. When this is selected, select 

the output paper size in the box. If you do not want to enlarge the document images when a larger paper size is 
selected, select the [Scale down only] check box.

3) Page Order
Select the page order for printing.

ColorSync
The ColorSync menu that is specific to color printers is not available for this equipment.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.
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Color Matching
The Color Matching menu that is specific to color printers is not available for this equipment.

This menu is displayed only for Mac OS X 10.5.x.

Cover Page
In the Cover Page menu, you can set whether to send a print job with a banner page. The banner page includes 
information about job owner, job name, application name, date and time, and printer name.

1) Print Cover Page
You can set how to insert a banner page.
- None — Select this option to print without a banner page.
- Before document — Select this option to print a banner page before the document.
- After document — Select this option to print a banner page after the document.

2) Cover Page Type
Select the type of the cover page.

3) Billing Info
Enter the billing information to have it appear on the banner page.

Due to Mac OS limitations, text input into the [Billing Info] box will only be displayed up to the length of the field.
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Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x.

1) PostScript Errors
This sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error information.
- Print detailed report — Select this option to print PostScript error information.

2) Tray Switching
This option is not supported by this equipment.

Paper Feed
In the Paper Feed menu, you can set the paper source.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this option is selected, select the 
paper source or paper type to be used in the box.

2) First page from
Select this option when you want to specify different paper sources for the first page and remaining pages. When this 
option is selected, select the paper source or paper type to be used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for remaining pages in the box. This option can be selected only 
when you select the [First page from] option.
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Print Mode
In the Print Mode menu, you can set the way this equipment handles the print job. This menu allows you to enable various 
job types, such as Private Print, Proof Print and Hold Print.

1) Print Mode
This option sets the type of print job.
- Normal — Select this option to print a job normally.
- Proof — Select this option to print the first copy of a multicopy job and then wait for approval before printing the 

remaining copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are 
saved in the proof job queue on this equipment, which are not printed until you activate printing from the touch 
panel display. This option allows you to check a job’s output before printing the remaining copies and thereby 
reduce paper waste.
For the detailed instructions on how to use the touch panel display, see the following page:

 P.132 “Proof Print jobs”
- Private — Select this option to print a private job. When this option is selected, specify the 5-digit password in the 

field next to the box. The print job is saved in the private job queue on this equipment, and not printed until you 
activate printing from the touch panel display of this equipment. This option is useful when you want to print a 
confidential document secured with a password. The user has to enter the password to print the private job when 
activating printing from the touch panel display.
For the detailed instructions on how to use the touch panel display, see the following page:

 P.135 “Private Print jobs”
- Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this 

equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is 
useful to prevent you from forgetting to remove printed sheets.
For the detailed instructions on how to use the touch panel display, see the following page:

 P.139 “Hold Print jobs”

2) Department Code
The Department Code feature can be used for managing each job. For example, a system administrator can check 
how many sheets of copies a certain department has made.
Select whether a department code is required for printing. When this option is enabled, specify the 5-digit department 
code in the field next to the box.
Enabling the department code depends on whether this equipment is managed with department codes or not. Ask your 
administrator for your department code.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode. When the Department Code Enforcement is set to “ON”, the invalid department code print job 
will be stored in the invalid department code print job list without being printed. When the Department Code 
Enforcement is set to “Print”, the invalid department code print job will be printed. When the Department Code 
Enforcement is set to “Delete”, the invalid department code print job will be deleted without being printed.
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3) Do not Print Blank Pages
Select whether to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.
Pages with header or footer will be printed even if the content is blank.

4) Distinguish Thin Lines
Select whether to print thin lines clearly.

Printer Features
In the Printer Features menu, you can set special printing features.

Finishing
In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This option selects the destination tray.
- Printer’s Default — Select this option to route the output to the default tray (that is set as the default tray for raw 

job in the Printer setting page of TopAccess Administrator’s page).
- Exit Tray — Select this option to route the output to the exit tray.
- Tray 1 — Select this option to route the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this option to route the output to the lower tray of the Finisher (optional).
- Job Separator Upper — Select this option to route the output to the upper tray of the Job Separator (optional).
- Job Separator Lower — Select this option to route the output to the lower tray of the Job Separator (optional).

Depending on the type of the optional Finisher and destination settings, stapling and hole punching may not be 
performed.
Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 
hole punching when [Printer’s Default] is selected as the [Destination] option.
For e-STUDIO355/455, [Tray 1] and [Tray 2] can be selected when the Finisher (optional) or Saddle Stitch 
Finisher MJ-1024 (optional) is installed. When the Hanging Finisher (optional) is installed, only [Tray 1] can be 
selected.
For e-STUDIO205L/255/305, only [Tray 1] can be selected when the Hanging Finisher (optional) or Saddle 
Stitch Finisher MJ-1025 (optional) is installed.
When the Job Separator (optional) is installed, you can select [Job Separator Upper] and [Job Separator Lower] 
instead of [Exit Tray].
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2) Hole Punch
This option sets whether or not a print job is hole punched.
- Off — Select this option to print without hole punches.
- Long Edge Punch without rotation — Select this option to create holes on the left side for a portrait document, or 

on the top for a landscape document.

- Short Edge Punch without rotation — Select this option to create holes on the top for a portrait document, or on 
the right for a landscape document.

- Long Edge Punch with 180 degree rotation — Select this option to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this option to create holes on the bottom for a portrait 
document, or on the left for a landscape document.

This option can be selected when the Hole Punch Unit (optional) is installed.

3) Stapling
This option sets whether a print job is stapled.
- Off — Select this option to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this option to staple on the upper left for a portrait 

document, or on the upper right for a landscape document.

- Middle Left (Portrait) / Middle Top (Landscape) — Select this option to double staple on the left for a portrait 
document, or on the top for a landscape document.
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- Lower Left (Portrait) / Upper Left (Landscape) — Select this option to staple on the lower left for a portrait 
document, or on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this option to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.

- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this option to double staple on the right for a 
portrait document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this option to staple on the lower right for a portrait 
document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this option to double staple on the top for a portrait 
document, or on the right for a landscape document.

- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this option to double staple on the bottom for a 
portrait document, or on the left for a landscape document.

- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this option to double staple in the center for a 
booklet to be printed. Select this only when booklet printing is performed.
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This option can be selected when the optional Finisher is installed.
Only [Upper Left (Portrait)/Upper Right (Landscape)] can be selected when the Hanging Finisher (optional) is 
installed.
[Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 
(optional) is installed.

Booklet
In the Booklet menu, you can set booklet printing.

1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed with two pages. The booklet size will be half the 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of the margin added to the center.

4) Booklet Outer Margin
Select the width of the margin added to the short edge side of a sheet.

Cover Pages
In the Cover Pages menu, you can set Front Cover printing and Back Cover printing.
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1) Use Front Cover
This option sets front cover printing which allows you to insert or print a cover on a sheet fed from a different drawer or 
the bypass tray.
To enable cover printing, select this check box and select the location from where a cover sheet is to be fed and the 
print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the Paper Feed menu.

Print Style
This option selects how to print the cover.
- Do not print on page — Select this option to insert a blank cover.
- Print on page — Select this option to print the first page image on the front side of a cover. When the Two-Sided 

Printing option is enabled in the Layout menu, the first two page images are printed on both sides of a cover.
- Print on 1 side of page — Select this option to print the first page image on the front side of a cover. This option is 

available only when the Two-Sided Printing option is enabled in the Layout menu.

2) Use Back Cover
This option sets back cover printing which allows you to insert or print a back cover on a sheet fed from a different 
drawer or the bypass tray.
To enable back cover printing, select this check box and select the location from where a back cover sheet is to be fed 
and the print style to be used.

Source
Select from where the cover sheet is to be fed. When [Auto (Default)] is selected, the paper is automatically selected 
according to the printed document size.

The selectable values in the [Source] box vary depending on the optional devices installed on this equipment and 
their configuration in the Paper Feed menu.

Print Style
This option selects how you want to print a back cover.
- Do not print on page — Select this option to insert a blank back cover.
- Print on page — Select this option to print the last page image on the front side of a back cover. When the Two-

Sided Printing option is enabled in the Layout menu, the last two page images are printed on both sides of a back 
cover.

- Print on 1 side of page — Select this option to print the last page image on the front side of a back cover. This 
option is available only when the Two-Sided Printing option is enabled in the Layout menu.
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Quality
In the Quality menu, you can specify various image quality features.

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.

Summary
In the Summary menu, you can confirm the current settings for printing.
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Print dialog on Mac OS X 10.2.x
The [Print] dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the application.

The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.5.x. See the 
following section for the descriptions of the [Print] dialog box for Mac OS X 10.3.x to Mac OS X 10.5.x.

 P.88 “Print dialog on Mac OS X 10.3.x to Mac OS X 10.5.x”

The [Print] dialog box varies depending on applications.

Copies & Pages
In the Copies & Pages menu, you can set the general print options such as number of copies and sort printing.

1) Copies
This option sets the number of printed copies.

2) Collated
Select this check box for sort-printing (1, 2, 3... 1, 2, 3...).

3) Pages
This option sets the pages to be printed.
- All — Select this option to print all pages.
- From/to — Select this option to specify the pages to be printed. Enter the page range in the [From] and [to] boxes.

Layout
In the Layout menu, you can set N-up printing (multiple pages per sheets). The items in the Layout menu vary depending 
on the Mac OS X version.

1 2

3

1

2

3



3.PRINTING FROM MACINTOSH

Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.5.x    103

3 PRINTING FROM MACINTOSH

1) Pages per Sheet
This option sets the number of multiple pages to be printed on one sheet. The pages are reduced to fit the selected 
paper size automatically and are printed.
- 1 — Select this option if you do not wish to perform N-up printing.
- 2 — Select this option to print images from 2 pages arranged on one sheet.
- 4 — Select this option to print images from 4 pages arranged on one sheet.
- 6 — Select this option to print images from 6 pages arranged on one sheet.
- 9 — Select this option to print images from 9 pages arranged on one sheet.
- 16 — Select this option to print images from 16 pages arranged on one sheet.

2) Layout Direction
This option sets how pages are arranged on one sheet. This option is available only when N-up printing (printing 
multiple sheets on a page) is enabled.

3) Border
Select if a border line is to be drawn on each page.
- None — Select this option if no border line is to be drawn.
- Single hairline — Select this option to draw a single hairline for the border.
- Single thin line — Select this option to draw a single thin line for the border.
- Double hairline — Select this option to draw a double hairline for the border.
- Double thin line — Select this option to draw a double thin line for the border.

Duplex
In the Duplex menu, you can set Two-Sided printing (printing on both sides of a sheet).

1) Print on Both Sides
Select this check box to print on both sides of the paper. When this box is selected, select the binding direction at the 
[Binding] option.

2) Binding
This option sets the type of binding for Two-sided printed pages.
- Long-edge Binding — Select this option to bind along the long edge side of paper. The direction to be printed on 

the back side of the paper differs depending on the orientation.

Across Left to Right Before Down — Pages arranged horizontally from left to right and then top to bottom 
on one sheet.

Across Right to Left Before Down — Pages arranged horizontally from right to left and then top to bottom 
on one sheet.

Down Before Across Left to Right — Pages arranged vertically from top to bottom and then left to right on 
one sheet.

Down Before Across Right to Left — Pages arranged vertically from top to bottom and then right to left on 
one sheet.
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- Short-edge Binding — Select this option to bind along the short edge side of paper. The direction to be printed on 
the back side of the paper differs depending on the orientation.

Output Options
In the Output Options menu, you can save a print job as a file.

1) Save as File
Select this check box to save a print job as a file. When this box is selected, select the file type in the [Format] box.

2) Format
This option sets the format to save a file.
- PDF — Select this option to save a print job as a PDF file.
- PostScript — Select this option to save a print job as a PS file.

Error Handling
In the Error Handling menu, you can set how to report a PostScript error.

1) PostScript Errors
This option sets whether to print a PostScript error report.
- No special reporting — Select this option if you do not want to print PostScript error information.
- Print detailed report — Select this option to print PostScript error information.

2) Tray Switching
This option is not supported by this equipment.
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Paper Feed
In the Paper Feed menu, you can select the paper source or media type.

1) All pages from
Select this option when you want to use the same paper source for all pages. When this option is selected, select the 
paper source or paper type to be used in the box.

2) First page from
Select this option when you want to specify different paper source for the first page and remaining pages. When this 
option is selected, select the paper source or paper type to be used for the first page in the box.

3) Remaining from
Select the paper source or paper type to be used for the remaining pages in the box. This option can be selected only 
when you select the [First page from] option.

Printer Features
In the Printer Features menu, you can set special printing features.

 P.105 “Booklet”
 P.106 “Quality”
 P.107 “Finishing”
 P.110 “Printing Modes”
 P.111 “Printing Modes DC”
 P.112 “Private Document Password”

Do not use the Cover Pages menu.

Booklet
In the Booklet menu, you can set booklet printing.
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1) Booklet Paper Size
Select a paper size for the booklet. Both sides of a sheet are printed with two pages. The booklet size will be half the 
size of the paper size that you specify.

2) Left to Right Page Layout
Select this check box to create a booklet that can be read from left to right.

3) Booklet Center Margin
Select the width of space added to the center.

4) Booklet Outer Margin
Select the width of space added to the short edge side of a sheet.

Quality
In the Quality menu, you can specify various image quality features.

1) Halftone
This option sets how to print halftones.
- Auto — Select this option to print using proper halftone depending on the contents in the document automatically.
- Detail — Select this option to print halftone in detail.
- Smooth — Select this option to print halftone smoothly.

2) Smoothing
Select this check box to print texts and graphics smoothly.

3) Toner Save
Select this check box to print in the Toner Save mode.

When the Toner Save mode is enabled, printing may become light.
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Finishing
In the Finishing menu, you can set the destination, hole punching and stapling.

1) Destination
This option selects the destination tray.
- Printer’s Default — Select this option to route the output to the default tray (that is set as the default tray for raw 

job in the Printer setting page of TopAccess Administrator’s page).
- Exit Tray — Select this option to route the output to the exit tray.
- Tray 1 — Select this option to route the output to the upper tray of the Finisher (optional).
- Tray 2 — Select this option to route the output to the lower tray of the Finisher (optional).
- Job Separator Upper — Select this option to route the output to the upper tray of the Job Separator (optional).
- Job Separator Lower — Select this option to route the output to the lower tray of the Job Separator (optional).

Depending on the type of the optional Finisher and destination settings, stapling and hole punching may not be 
performed.
Depending on the equipment settings, the paper may be delivered to a tray that cannot carry out stapling or 
hole punching when [Printer’s Default] is selected as the [Destination] option.
For e-STUDIO355/455, [Tray 1] and [Tray 2] can be selected when the Finisher (optional) or Saddle Stitch 
Finisher MJ-1024 (optional) is installed. When the Hanging Finisher (optional) is installed, only [Tray 1] can be 
selected.
For e-STUDIO205L/255/305, only [Tray 1] can be selected when the Hanging Finisher (optional) or Saddle 
Stitch Finisher MJ-1025 (optional) is installed.
When the Job Separator (optional) is installed, you can select [Job Separator Upper] and [Job Separator Lower] 
instead of [Exit Tray].

2) Hole Punch
This option sets whether or not a print job is hole punched.
- Off — Select this option to print without hole punches.
- Long Edge Punch without rotation — Select this option to create holes on the left side for a portrait document, or 

on the top for a landscape document.

- Short Edge Punch without rotation — Select this option to create holes on the top for a portrait document, or on 
the right for a landscape document.
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- Long Edge Punch with 180 degree rotation — Select this option to create holes on the right side for a portrait 
document, or on the bottom for a landscape document.

- Short Edge Punch with 180 degree rotation — Select this option to create holes on the bottom for a portrait 
document, or on the left for a landscape document.

This option can be selected when the Hole Punch Unit (optional) is installed.

3) Stapling
This option sets whether a print job is stapled.
- Off — Select this option to print without stapling.
- Upper Left (Portrait) / Upper Right (Landscape) — Select this option to staple on the upper left for a portrait 

document, or on the upper right for a landscape document.

- Middle Left (Portrait) / Middle Top (Landscape) — Select this option to double staple on the left for a portrait 
document, or on the top for a landscape document.

- Lower Left (Portrait) / Upper Left (Landscape) — Select this option to staple on the lower left for a portrait 
document, or on the upper left for a landscape document.

- Upper Right (Portrait) / Lower Right (Landscape) — Select this option to staple on the upper right for a portrait 
document, or on the lower right for a landscape document.
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- Middle Right (Portrait) / Middle Bottom (Landscape) — Select this option to double staple on the right for a 
portrait document, or on the bottom for a landscape document.

- Lower Right (Portrait) / Lower Left (Landscape) — Select this option to double staple on the lower right for a 
portrait document, or on the lower left for a landscape document.

- Middle Top (Portrait) / Middle Right (Landscape) — Select this option to double staple on the top for a portrait 
document, or on the right for a landscape document.

- Middle Bottom (Portrait) / Middle Left (Landscape) — Select this option to double staple on the bottom for a 
portrait document, or on the left for a landscape document.

- Saddle Stitch (Portrait) / Saddle Stitch (Landscape) — Select this option to double staple in the center for a 
booklet to be printed. Select this only when booklet printing is performed.

This option can be selected when the optional Finisher is installed.
Only [Upper Left (Portrait)/Upper Right (Landscape)] can be selected when the Hanging Finisher (optional) is 
installed.
[Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can be selected only when the Saddle Stitch Finisher 
(optional) is installed.
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Printing Modes
In the Printing Modes menu, you can set the way this equipment handles the print job. This menu allows you to enable 
various job types, such as Private Print, Proof Print and Hold Print.

1) Print Mode
This option sets the type of print job.
- Normal — Select this option to print a job normally.
- Hold — Select this option to print a hold job. The print job, sent as a hold job, is saved in the hold job queue on this 

equipment. To perform printing, select the desired job on the touch panel display and press [PRINT]. This option is 
useful to prevent you from forgetting to remove printed sheets.
For the detailed instructions on how to use the touch panel display, see the following page:

 P.139 “Hold Print jobs”
- Proof — Select this option to print the first copy of a multicopy job and then wait for approval before printing the 

remaining copies. If a print job is sent as a proof job, one copy of the job is printed and the remaining copies are 
saved in the proof job queue on this equipment, which are not printed until you activate printing from the touch 
panel display. This option allows you to check a job’s output before printing the remaining copies and thereby 
reduce paper waste.
For the detailed instructions on how to use the touch panel display, see the following page:

 P.132 “Proof Print jobs”
- Private - Password — Select this option to print a private job. When this is selected, specify the 5-digit password 

in the Private Document Password menu. The print job is saved in the private job queue on this equipment, and not 
printed until you activate printing from the touch panel display of this equipment. This option is useful when you 
want to print a confidential document secured with a password. The user has to enter the password to print the 
private job when activating printing from the touch panel display.
For details on the Private Document Password menu, see the following page:

 P.112 “Private Document Password”
For the detailed instructions on how to use the touch panel display, see the following page:

 P.135 “Private Print jobs”

2) Department Code
The Department Code feature can be used for managing each job. For example, a system administrator can check 
how many sheets of copies a certain department has made.
Select this check box if a department code is required for printing. When this option is enabled, specify the 5-digit 
department code in the DC menu.
Enabling the department code depends on whether this equipment is managed with department codes or not. Ask your 
administrator for your department code.

 P.111 “Printing Modes DC”

3) Distinguish Thin Lines
Select this check box to print thin lines clearly.

4) Do not Print Blank Pages
Select this check box to ignore blank pages for printing.

When more than 2 is selected at the [Page per Sheet] option in the Layout menu, the blank pages will be 
printed.
Pages with header or footer will be printed even if the content is blank.
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Printing Modes DC
In the Printing Modes DC menu, you can specify your department code, if the Department Code option is enabled on the 
equipment. Before specifying the department code, you must check the Department Code option in the Printing Modes 
menu. Then specify the department code in this menu.

How the equipment performs printing for an invalid department code print job, for which an invalid department code is 
specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode. When the Department Code Enforcement is set to “ON”, the invalid department code print job will 
be stored in the invalid department code print job list without being printed. When the Department Code Enforcement 
is set to “Print”, the invalid department code print job will be printed. When the Department Code Enforcement is set to 
“Delete”, the invalid department code print job will be deleted without being printed.

1) Department Code (DC) - Digit 1
Select the first digit of the department code.

2) Department Code (DC) - Digit 2
Select the second digit of the department code.

3) Department Code (DC) - Digit 3
Select the third digit of the department code.

4) Department Code (DC) - Digit 4
Select the fourth digit of the department code.

5) Department Code (DC) - Digit 5
Select the fifth digit of the department code.
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Private Document Password
In the Private Document Password menu, you can specify the Document ID number for the private job. It is recommended 
to specify the Private Document Password when you select to print a private job. If you do not specify the Private 
Document Password, the private job uses the default Private Document Password “00000”.

1) Password - Digit 1
Select the first digit of the Document ID.

2) Password - Digit 2
Select the second digit of the Document ID.

3) Password - Digit 3
Select the third digit of the Document ID.

4) Password - Digit 4
Select the fourth digit of the Document ID.

5) Password - Digit 5
Select the fifth digit of the Document ID.

Summary
In the Summary menu, you can confirm the current settings for printing.
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Printing from an Application

This section describes how to print from a UNIX/Linux workstation.

When the User Management Setting is enabled on the equipment, the print jobs that are sent from UNIX/Linux 
workstations are processed as invalid jobs according to the Department Code Enforcement setting.
Before attempting to print from a UNIX/Linux workstation, make sure all the UNIX/Linux Filters are installed in your 
workstation.

For instructions on how to install or set CUPS, refer to the Software Installation Guide.

Considerations and limitations
This equipment acts only as a filter and not as a complete driver. The size and order of the printed pages cannot be 
modified.
The UNIX/Linux filters do not support the following engine-supplied features:
- Enlarge/Reduce printing
- Rotate Sort
- N-up printing
- Watermarks
- Cover Sheets
- Sheet Insertion
- Scheduled Print
- Print to Overlay File
- Store to e-Filing
- Use Overlay Image

Linux uses the lptap command to send a file to this equipment.
Since lp is not supported in all versions of Linux, the lptap command should be used instead.
AIX supports printing using the qdaemon. This can be invoked by the user with the commands lp, lpr or qprt. In order 
to use the filter, either lp or qprt should be used.

Printing using lp command
Use the lp command (lptap in Linux) to send a file to this equipment for printing. This command specifies various printer-
specific options using the -o option parameter on the command line. The lp command also sets other print options using 
various other parameters. Use the “man net_estbw” command to display the online document that describes the various 
options and parameters that can be set to configure printed output.
All the options are sent to this equipment at the start of a print job so, if the print file contains its own commands, they may 
override the lp options.

Generic “lp” and “lptap” options

How to print files
Enter the following “Ip” command to print files with the specified printer:
“lp -d <queuename> <filename>”

Copies
The number of copies of a print job is specified using the “-n <value>” parameter with the “lp” command. The default value 
is determined by the “lp” command and it is always 1. The copies are always collated.

Title
The title that is printed on the banner page can be specified using the “-t <title>” parameter with the “lp” command. The 
default value is determined by the “lp” command and it is often the name of the print file. If multiple files are printed using 
the same “lp” command the default title is set to the name of the first file by the “lp” command.
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General options
The following options apply to all print files.

Option commands are case sensitive and must be entered exactly as shown.
Some printing functions may be disabled depending on the combinations of option commands because priority is 
given to the specifications of this equipment over option commands.

Print Language
The “net_estbw” program needs to know what printer language is used in each of the files that it is printing so that it can 
issue the correct commands to select various options. The following options are valid for the print languages.

All PCL5e jobs automatically send the “<esc>&k2G” command to convert the line-feed character into a carriage-return - 
line-feed sequence. If the PCL5e job contains some of its own escape sequences it may override this setting.
The default print language is “auto”.
Example: The command to specify that a file is PostScript is “lp -d <queuename> -o ps <filename>”.

Stapling
This option sets whether a print job is printed with staples. When the optional Finisher is installed, you can specify the 
stapling position using the following options.

Option Value Alternate Value Description
auto Each file to be printed is examined to see if it starts with 

the “%!” sequence. If it does, then it is assumed that it is 
a PostScript file, otherwise it assumes that it is a plain 
text or a PCL6 file.

pcl The print file is always treated as a plain text or a PCL6 
file.

postscript ps The file is always treated as a PostScript file.

raw The file is treated as a fully formatted file that already 
contains all the necessary commands. The file is sent to 
the printer without any modifications. In this mode no 
other options are valid and a banner page is not printed.

Option Value Alternate Value Description
staple=0 Stapling is turned off.

staple=1 Staple in the top left corner of a portrait page and the 
upper right corner of a landscape page.

staple=2 Put two staples on the left side of a portrait page or the 
top side of a landscape page printed on long-edge-feed 
paper. This command has no effect when the paper is 
fed from the short-edge side.

staple=3 Staple in the bottom left corner of a portrait page and 
the upper left corner of a landscape page.

staple=4 Staple in the top right corner of a portrait page and the 
bottom right corner of a landscape page.

staple=5 Put 2 staples on the right side of a portrait page or the 
bottom side of a landscape page printed on long-edge-
feed paper. This command has no effect when the 
paper is fed from the short-edge side.

staple=6 Staple in the bottom right corner of a portrait page and 
the lower left corner of a landscape page.

staple=7 Put 2 staples on the top side of a portrait page or the 
right side of a landscape page printed on short-edge-
feed large format (A3/Ledger) paper. This command 
has no effect when the paper is fed from the long-edge 
side or small paper size.
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If this option is not specified, the printer’s default value will be used.
Example: The command to staple in the upper left corner of a long edge feed portrait page is “lp -d <queuename> -o 
staple=1 <filename>”.
The value for the stapling position depends on the paper size, the paper feed direction, and the print direction. This 
function is not available for all paper sizes and the users should refer to the Quick Start Guide for a list of compatible 
paper sizes. In particular, A5, A6 and statement paper sizes will not work with this function.

Output Bin
The output bin can be specified using the following options.

If the optional Finisher is not installed on the equipment, the default output tray will be used (inner). If the optional Finisher 
is installed on the equipment, the default output tray will be used (bin2).
Example: The command to specify output bin 1 is “lp -d <queuename> -o bin1 <filename>”.

Hole Punching
This option sets whether a print job is printed with hole punches. When the optional Hole Punch Unit is installed, you can 
use the hole punching function using the following options.

If this option is not specified, the default value of “nopunch” will be used.
This function is not available for all paper sizes and the users should refer to the Quick Start Guide for a list of compatible 
paper sizes. In particular, A5, A6 and statement paper sizes will not work with this function.
Example: The command to hole punch the long edge feed portrait page is “lp -d <queuename> -o punch=1 <filename>”.

staple=8 Put 2 staples on the bottom side of a portrait page or 
the left side of a landscape page printed on short-edge-
feed large format (A3/Ledger) paper. This command 
has no effect when the paper is fed from the long-edge 
side or small paper size.

staple=9 Put 2 staples in the middle of a landscape page and fold 
the paper in half vertically along the staple line (saddle 
stitching). This command works in conjunction with 
booklet printing. This command has no effect when the 
paper is fed from the long-edge side.

Option Value Alternate Value Description
inner Select the exit tray.

bin1 Select the upper output tray of the optional Finisher.

bin2 Select the lower output tray of the optional Finisher.

jsp1 Select the upper output tray of the optional Job 
Separator.

jsp2 Select the lower output tray of the optional Job 
Separator.

Option Value Alternate Value Description
punch=0 nopunch Hole punching is turned off.

punch=1 Hole punch on long edge without rotation.

punch=2 Hole punch on short edge without rotation.

punch=3 Hole punch on long edge with 180 degree rotation.

punch=4 Hole punch on short edge with 180 degree rotation.

Option Value Alternate Value Description
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Media Type
The paper source can be selected using the following options to specify the media type.

In PostScript, Deferred Media Selection is always turned on so the paper size has priority over the media type and the 
paper source.
In PCL5e, the paper size always has priority over the media type and the paper source.
If this option is not specified, the default value will be used.
Example: The command to specify Thick1 media type is “lp -d <queuename> -o mtype=Thick1 <filename>”.

Paper Source
The paper source can be selected using the following options.

In PostScript, Deferred Media Selection is always turned on so the paper size has priority over the paper source. In 
PCL5e, the paper size always has priority over the paper source.
If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to specify the drawer 1 paper source is “lp -d <queuename> - o drawer1 <filename>”.

Duplexing
The current duplex mode can be specified using the following options.

If this option is not specified, the default value “simplex” will be used.
It is not necessary to specify duplexing for Booklet Mode (sduplex). Setting duplexing separately can override the booklet 
mode setting for duplexing.
Example: The command to specify long edge duplexing is “lp -d <queuename> -o duplex <filename>”.

Option Value Alternate Value Description
mtype=Plain The paper source that contains Plain paper is 

requested.

mtype=
Transparency

The paper source that contains Transparency Slides is 
requested.

mtype=Thick1 The paper source that contains Thick1 paper is 
requested.

mtype=Thick2 The paper source that contains Thick2 paper is 
requested.

mtype=Thick3 The paper source that contains Thick3 paper is 
requested.

Option Value Alternate Value Description
auto-source Select auto paper tray selection.

manual Select Bypass Tray.

drawer1 upper
cas1

Select the 1st drawer.

drawer2 lower
cas2

Select the 2nd drawer.

drawer3 pedupper
cas3

Select the 3rd drawer (optional).

drawer4 pedlower
cas4

Select the 4th drawer (optional).

lcf tandem Select the Large Capacity Feeder (optional). The Large 
Capacity Feeder (optional) is not available for some 
countries or regions.

Option Value Alternate Value Description
simplex Turn duplexing off.

duplex lduplex
duplex_long
duplex=long
hduplex

Turn duplexing on with long edge binding.

sduplex duplex_short
duplex=short
vduplex

Turn duplexing on with short edge binding.
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Paper Size
The current paper size can be specified using the following options.

If this option is not specified, the printer’s default value will be used.
Example: The command to specify the A4 paper size is “lp -d <queuename> -o a4 <filename>”.

Printing Modes
The printing mode can be selected using the following options.

If this option is not specified, the printer’s default value will be used.
A private printing job requires the user to enter a password with a maximum number of 63 characters long.
Character lengths longer than 63 will be clipped to 63.
The following characters are invalid, but no type checking is carried out.
” & ’ ( ) ; < > ˆ ` | ~ @ # % * !

Option Value Alternate Value Description
letter lt

LT
Select letter size paper.

A4 a4 Select A4 size paper.

legal lg
LG

Select legal size paper.

statement st
ST

Select statement size paper.

ledger ld
LD

Select ledger size paper.

folio folio-japan Select folio size paper.

A3 a3 Select A3 size paper.

A5 a5 Select A5 size paper.

A6 a6 Select A6 size paper.

B4 b4
b4-jis
B4-JIS

Select JIS B4 size paper.

B5 b5
b5-jis
B5-JIS

Select JIS B5 size paper.

computer co
CO

Select computer size paper.

legal13 lg13
LG13

Select LG13inch size paper.

sq85 letter-square Select SQ8.5inch size paper.

postcard Select postcard size paper.

8K 8k Select 8K size paper.

16K 16k Select 16K size paper.

Option Value Alternate Value Description
normal Process as a normal print job.

proof Process as a proof print job.

private=din Process as a private print job. The din is up to a 63-digit 
(between 1 to 63) password.

hold Process as a hold print job.
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Department Code
The department access code can be set using the following option.

How the equipment performs printing for an invalid department code print job, for which an invalid department code 
is specified, varies depending on the Department Code Enforcement setting that can be set from TopAccess 
Administrator mode. When the Department Code Enforcement is set to “ON”, the invalid department code print job 
will be stored in the invalid department code print job list without printing. When the Department Code Enforcement 
is set to “Print”, the invalid department code print job will be printed. When the Department Code Enforcement is 
set to “Delete”, the invalid department code print job will be deleted without printing.
For the appropriate department code, ask your system administrator.

Smoothing
This option sets whether to print text and graphics smoothly. This mode can be set using the following options.

Example: The command to set the smoothing mode is “lp -d <queuename> -o smoothing=on <filename>”.

Distinguish Thin Lines
This option sets whether to distinguish thin lines or not. This mode can be set using the following options.

Example: The command to set the thin line limit mode is “lp -d <queuename> -o thinlinelimit=on <filename>”.

Do not Print Blank Pages
This option sets whether or not a blank page is printed. This mode can be selected using the following options.

Example: The command to set the blank page mode is “lp -d <queuename> -o blankpage=0 <filename>”.

Toner Save
The toner save mode can be set using the following options.

Example: The command to set the toner save mode is “lp -d <queuename> -o tonersave=on <filename>”.

Option Value Alternate Value Description
dept=code Set the department access code. The code is a 5-digit 

numeric value.

Option Value Alternate Value Description
smoothing=on ON Set the smoothing mode.

smoothing=off OFF Cancel the smoothing mode.

Option Value Alternate Value Description
thinlinelimit=on ON Set the thin line limit mode.

thinlinelimit=off OFF Cancel the thin line limit mode.

Option Value Alternate Value Description
blankpage=0 Set the blank page mode (disable Do not Print Blank 

Pages).

blankpage=1 Cancel the blank page mode (enable Do not Print Blank 
Pages).

Option Value Alternate Value Description
tonersave=on ON Set the toner save mode.

tonersave=off OFF Cancel the toner save mode.
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Booklet Modes
The booklet mode can be selected using the following options.

The booklet mode applies only for the PostScript data. Performing the booket printing using the PCL data is invalid.

In a job, if this value is LT, and in PDL also the data is for LT paper size, this will result in a scaled booklet on Letter paper. 
In a job, if this value is A3, and in PDL the data is for A4 paper size, this will result in a tiled booklet on A3 paper.
When the booklet mode option is selected, the paper size is automatically set to the same size as booklet mode. This 
function is only available for A3, A4, B4, Letter and Ledger paper sizes.
If the booklet mode is selected, duplexing is also selected automatically (sduplex). Setting duplexing separately can 
override the booklet mode setting for duplexing.
Example: The command to select the letter size paper for the booklet printing mode is “lp -d <queuename> -o 
booklet=letter <filename>”.

Option Value Alternate Value Description
booklet=letter lt

LT
Select letter size paper for the booklet printing mode.

booklet=A4 a4 Select A4 size paper for the booklet printing mode.

booklet=legal lg
LG

Select legal size paper for the booklet printing mode.

booklet=
statement

st
ST

Select statement size paper for the booklet printing 
mode.

booklet=ledger ld
LD

Select ledger size paper for the booklet printing mode.

booklet=folio folio-japan Select folio size paper for the booklet printing mode.

booklet=A3 a3 Select A3 size paper for the booklet printing mode.

booklet=A5 a5 Select A5 size paper for the booklet printing mode.

booklet=B4 b4
B4-JIS
b4-jis

Select JIS B4 size paper for the booklet printing mode.

booklet=B5 b5
B5-JIS
b5-jis

Select JIS B5 size paper for the booklet printing mode.

booklet=
computer

co
CO

Select computer size paper for the booklet printing 
mode.

booklet=legal13 lg13
LG13

Select legal-13 size paper for the booklet printing mode.

booklet=SQ85 sq85
letter-square

Select 8.5 inch square size paper for the booklet 
printing mode.

booklet=8K 8k Select 8K size paper for the booklet printing mode.

booklet=16K 16k Select 16K size paper for the booklet printing mode.
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Page Layout
The booklet mode page layout can be selected using the following options.

Example: The command to select left to right page layout for booklet printing mode is “lp -d <queuename> -o left2right=on 
<filename>”.

Center Margin
The center margin applied for the booklet mode can be selected using the following options.

Example: The command to select the center margin value for booklet printing mode is “lp -d <queuename> -o 
centermargin=value <filename>”.

Outer Margin
The outer margin applied for the booklet mode can be selected using the following options.

Example: The command to select the outer margin value for booklet printing mode is “lp -d <queuename> -o 
outermargin=value <filename>”.

Option Value Alternate Value Description
left2right=off OFF Select right to left page layout for the booklet printing 

mode.
This value decides the layout of the pages in the 
booklet.
If this value is OFF then the layout of pages is Right to 
Left as shown in the figure below.

left2right=on ON Select left to right page layout for the booklet printing 
mode.
This is the default setting.
If the value is ON then the layout of the pages is from 
Left to Right as shown in the figure below.

Option Value Alternate Value Description
centermargin
=value

Select the center margin value for the booklet printing 
mode.
This value specifies the Center Margin or the “Gutter” in 
pixels. This is in addition to the center margin already 
specified by the application. The valid range for value is 
0 to 300. Default is 0.

Option Value Alternate Value Description
outermargin
=value

Select the outer margin value for the booklet printing 
mode.
This value specifies the Outer Margin or the “Creep” in 
pixels per page, which should take place while printing 
a booklet. The valid range for value is 0 to 600. Default 
is 0.
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Collate
The collate option can be selected using the following options.

If this option is not specified, the default value of “collate=on” will be used.
Example: The command to select collate off is “lp -d <queuename> -o collate=off <filename>”.

Orientation
The following orientation options are available.

If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to specify landscape orientation is “lp -d <queuename> -o landscape <filename>”.

Font Pitch
If the pitch is specified, the net_estbw program will always select the Courier font; otherwise the default font is used. The 
following options are used to select the font pitch.

In all the cases shown above, the Courier font will also be selected. When the pitch is changed, the font size will 
automatically be scaled to the appropriate size.
If this option is not specified, the default pitch and font will be used.
Example: The command to specify 8 characters per inch is “lp -d <queuename> -o pitch=8 <filename>”.

Page Length
The number of lines to print on a page can be specified with the following option.

As this equipment is a page printer, we cannot change the physical length of a piece of paper so the actual effect of this 
command is to change the value for lines per inch so that the requested number of lines is printed on the page. The actual 
page length may differ from this value if the top margin or the text length option is used.
If this option is not specified, the PJL command will not be sent so the printer’s default value will be used. The minimum 
page length allowable is 5. If value is less than 5, page length is set to 5.
The command to specify 66 lines per page is “lp -d <queuename> -o pl=66 <filename>”.

Option Value Alternate Value Description
collate=off OFF Cancel the collate printing mode.

collate=on ON Set the collate printing mode.

Option Value Alternate Value Description
portrait Print the document in portrait orientation.

landscape Print the document in landscape orientation.

Option Value Alternate Value Description
c pitch=16.67 Set the character pitch to 16.67 characters per inch.

10 pitch=10 Set the character pitch to 10 characters per inch.

12 pitch=12 Set the character pitch to 12 characters per inch.

pitch=value Set the character pitch to value characters per inch.

Option Value Alternate Value Description
pl=value Set the lines per page to value.
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PCL5e Specific Options
Some of the options only apply to plain text or PCL5e files.

Text Wrapping
The following options control text wrapping when it reaches the right margin.

If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to specify wrapping is “lp -d <queuename> -o wrap <filename>”.

Left Margin
The left margin position can be specified with the following option.

If the left margin is set to the right of the right margin, it will be ignored.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the left margin to five columns is “lp -d <queuename> -o lm=5 <filename>”.

Right Margin
The right margin position can be specified with the following option.

If the right margin is set to the left of the left margin or if it is set to a position wider than the logical page, it will be ignored. 
The right margin is specified in columns from the left margin. A negative value will be ignored.
If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to set the right margin to fifty columns is “lp -d <queuename> -o rm=50 <filename>”.

Top Margin
The top margin position can be specified with the following option.

If the top margin is set too high or too low, part of the text may not appear due to the printer’s unprintable region. The top 
margin will be ignored if it is set to a value greater than the printer’s logical page length. Setting this value may affect the 
number of lines specified using the page length option.
If this option is not specified, the command will not be sent so the printer’s default value will be used.
Example: The command to set the top margin to ten lines is “lp -d <queuename> -o tm=10 <filename>”.

Text Length
The text length can be specified using the following option.

If the text length is set too high, part of the text may not appear due to the printer’s unprintable area. The text length will be 
ignored if it is set to a value greater than the printer’s logical page length minus the top margin. The text length is specified 
in rows from the top margin. Setting this value may affect the number of lines specified using the page length option.
If this option is not specified the command will not be sent so the printer’s default value will be used.
Example: The command to set the text length to 40 lines is “lp -d <queuename> -o tl=40 <filename>”.

Option Value Alternate Value Description
wrap Enable automatic text wrapping.

nowrap Disable automatic text wrapping.

Option Value Alternate Value Description
lm=value Set the left margin to value columns.

Option Value Alternate Value Description
rm=value Set the right margin to value columns.

Option Value Alternate Value Description
tm=value Set the top margin to value lines.

Option Value Alternate Value Description
tl=value Set the length to value lines.
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Banner Page
A banner page is automatically generated for each file in each job. The banner page is always sent as a PCL5e job, 
including the following items.

The name of the user that submitted the print job
The job ID number and from which workstation it was submitted
The title of the job
This title can be specified using the “-t” option. The same title is used for every file within a job. The default title is 
controlled by the “lp” command.
The name of the printer or its IP address
The date and time when the job was printed according to the print server

Only one copy of the banner page is printed for each file, even if a number of copies of the job are requested. The banner 
page is sent to the equipment as a separate sub-job so that it is never stapled to the document.
The banner page is printed with the following settings.

Copies = 1
Stapling off
Hole punching off
Orientation = portrait
Duplex off
Paper size as requested by the “-o” parameter or the printer’s default value
The paper source and the media type for the banner page can be set to different values than the job’s paper source 
and media type.
Auto paper source selection or the requested banner page source or media type
Output bin as requested by the “-o” parameter or the printer default value
6 lines per inch
Auto-wrap on
Automatic carriage-return when a line-feed is sent

The banner page is designed to fit paper bigger than Statement / A5.
The banner page uses the default paper size if paper is set to:
- Statement
- A5
- A6
- B5
- Postcard

When the language is set to “raw” the banner is always disabled.
The paper source and the media type for the banner page can be set to different values than the job’s paper source 
and media type. If a banner paper source is not specified then the auto source command is sent. If a banner media 
type is not specified then no banner media type command is sent, so the printer’s default value will be used.
If the file being printed specifies the paper destination or the paper size internally the banner page may print to the 
wrong output or on an incorrect paper size.
Hole punching cannot be applied to banner pages.
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Banner Options
The banner page can be printed using the following options.

The default value for this option is that the banner page prints first.
Example: The command to printing the banner page after the job is “lp -d <queuename> -o banner=last <filename>”.

Banner Paper Source
The banner paper source can be specified using the following options.

If the banner paper source is not specified the PCL5e auto paper source command “<esc>&l7H” will be sent. The banner 
page source cannot be set to manual feed. The paper size always has priority over the paper source.
Example: The command to specify that the banner page paper source is the Large Capacity Feeder is “lp -d 
<queuename> -o blcf <filename>”.

Banner Media Type
The banner page paper source can be selected using the following options to specify the media type.

The paper size always has priority over the media type and the paper source.
If this option is not specified the command will not be sent so the printer’s default value will be used to print the banner 
page.
Example: The command to specify that the banner page should be printed on Plain paper is “lp -d <queuename> -o 
bmtype=Plain <filename>”.

Option Value Alternate Value Description
banner=last Print the banner page after the job so that it will be 

physically on top of the job in the output tray.

banner=first banner Print the banner page before the job so that it will be 
physically under the job in the output tray.

nobanner nb Do not print a banner. The ability to specify the 
“nobanner” option can be disabled by the system 
administrator to force all jobs to print with a banner.

Option Value Alternate Value Description
bauto-source Select the auto paper tray selection.

bdrawer1 bupper
bcas1

Select the 1st drawer.

bdrawer2 blower
bcas2

Select the 2nd drawer.

bdrawer3 bpedupper
bcas3

Select the 3rd drawer (optional).

bdrawer4 bpedlower
bcas4

Select the 4th drawer (optional).

blcf BLCF
btandem

Select the Large Capacity Feeder (optional). The Large 
Capacity Feeder (optional) is not available for some 
countries or regions.

Option Value Alternate Value Description
bmtype=Plain The paper source that contains Plain paper is 

requested.

bmtype=
Transparency

The paper source that contains Transparency Slides is 
requested.

bmtype=Thick1 The paper source that contains Thick1 paper is 
requested.

bmtype=Thick2 The paper source that contains Thick2 paper is 
requested.

bmtype=Thick3 The paper source that contains Thick3 paper is 
requested.
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Monitoring the Print Job Status

Your print jobs can be monitored on the equipment’s touch panel. The types of print jobs you can monitor include Normal 
Print, Scheduled Print, Private Print, Hold Print and Proof Print. If the Department Management feature is enabled, the 
equipment can also display the Invalid jobs, which are held without being printed. You can view the status, as well as 
release, delete, pause/resume, and change the order of these jobs. Connecting a USB storage device to the equipment 
allows you to print PDF, encrypted PDF, XPS, JPEG, PRN and PS files contained in the media directly from the touch 
panel without using a client computer (USB Direct Printing).

If the equipment is managed by the User Management feature, you need to enter the user information, such as the 
user name and password.

 P.128 “Normal Print/Scheduled Print jobs”
 P.132 “Proof Print jobs”
 P.135 “Private Print jobs”
 P.139 “Hold Print jobs”
 P.143 “Invalid jobs”
 P.146 “Printing files from USB media (USB Direct Printing)”

Normal Print/Scheduled Print jobs
Pressing [JOB STATUS] on the touch panel displays the [JOBS] tab on the JOB STATUS screen. On the [JOBS] tab, the 
Normal Print and Scheduled Print jobs are listed together with the copy jobs. You can view each job’s user name, date and 
time, paper size, number of pages, number of copies, and current status. You can also delete, pause/resume, and change 
the order of the jobs on the list.

For the Scheduled Print jobs, “Scheduled” is indicated in the “Status” column.

Up to 1000 jobs can be listed. To display the previous or next page, press  or . The number of jobs displayed on a 
page may vary depending on the equipment used.

To exit from the JOB STATUS screen, press [CLOSE].

On the [JOBS] tab, you can select the desired mode for monitoring the status by pressing [PRINT], [FAX], or [SCAN]. 
For details on the scan or Internet fax job status, refer to the Scanning Guide. This equipment provides the scanning 
function as an option. However, this optional scanning function is already installed in some models.
For details on the fax job status, refer to the GD-1250 Operator’s Manual for FAX Unit (optional).
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Deleting jobs
Follow the procedure below when you want to delete unnecessary Normal Print/Scheduled Print jobs.

1 On the [JOBS] tab listing the print jobs (  P.128), select the job that you want to delete, 
and then press [DELETE].

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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Pausing/Resuming jobs
The eleventh or subsequent job, when counted from the one in progress, can be held in the queue (Pausing); the job in 
hold can be released again for printing (Resuming).

Pausing jobs
On the [JOBS] tab listing the print jobs (  P.128), select the job that you want to pause and then press [PAUSE].

The selected job is paused. When a job is paused, the subsequent jobs on the list will be processed earlier.

Resuming paused jobs
Select the job that you want to resume and then press [RESUME].
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Changing the job order
You can change the order of the jobs by moving them within the list.

You can only move the jobs from and to the 11th or subsequent position when counted from the one in progress.

1 On the [JOBS] tab listing the print jobs (  P.128), select the job that you want to move 
in the list, and then press [MOVE].

If the target job is not displayed on the page, use  and  to change between pages.

2 Specify the new position of the job. (The job will be moved to under the one selected 
here.)



5 MANAGING PRINT JOBS FROM THE CONTROL PANEL

132    Monitoring the Print Job Status

Proof Print jobs
Proof Print refers to the function to print only a single copy as a sample and suspend the rest of the job when printing 
multiple copies from a computer on the network.
After viewing the first copy, you can decide, on the Proof Print job list, whether to print out the remaining copies or cancel 
the job to change the settings. If you select to print the remaining copies, you can change the number of copies to print.
For the detailed instructions on Proof Print, see the following page:

 P.58 “Printing Proof Print jobs”

Displaying the Proof Print job list
Follow the procedure below when you want to display the list of Proof Print jobs.

2 Press [PROOF].

The Proof Print jobs are listed on the screen.

1 On the control panel, press the [PRINT] button.
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Printing remaining copies
Follow the procedure below if you have checked the first copy and want to print the remaining copies.

1 On the Proof Print job list (  P.132), select the job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.

2 Press [PRINT].

The remaining copies are printed out.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (  P.128).

To change the number of copies to print, press [EDIT] and enter the number of copies. Pressing [PRINT] starts 
the job.
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Deleting Proof Print jobs
Follow the procedure below to delete Proof Print jobs.

1 On the Proof Print job list (  P.132), select the job that you want to delete, and then 
press [DELETE].

If the target job is not displayed on the screen, use  and  to change between pages.

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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Private Print jobs
Private Print refers to the function to print a document from a computer on the network only when a set password is keyed 
in to the equipment’s control panel. This function is useful when you want to print confidential documents and prevent 
them from being seen by others. Private Print jobs can be released or deleted from the Private Print job list.
For the detailed instructions on Private Print, see the following page:

 P.56 “Printing Private Print jobs”

The Private Print function can be used when the user management setting is disabled on the equipment.

Displaying the Private Print job list
Follow the procedure below to display the list of Private Print jobs.

2 On the Private Print job list, select the desired user name and then press [PASSWORD].

When you enter the nickname for [User name (Alias)] on a Windows computer, and send the job to the 
equipment, its nickname will be displayed on the Private Print job list. If not, the user name that is entered to 
log in to your computer will be displayed on the Private Print job list.
If you perform the operation as an administrator, press [ADMIN. PASSWORD] instead of selecting a user 
name. The on-screen keyboard appears, with which you can enter the 6-to-10-digit administrator password. 
In this case, the jobs can be deleted but are not allowed to be printed. If you enter an incorrect password 
three times in a row, the equipment becomes unavailable for operation (for about 30 seconds). In this case, 
wait until the equipment becomes available again, and then enter the correct administrator password.

1 On the control panel, press the [PRINT] button.
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3 Enter the password for the Private Print job, which has previously been set via the 
computer, and then press [OK].

The Private Print jobs are listed on the screen.

When the Private Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the 

displayed list contains the Private Print jobs for which the same password has been set.
- When the nickname is entered for [User name (Alias)], the displayed list contains the Private Print jobs 

for which the same nickname and the same password have been set.
When the Private Print job is sent from a Macintosh computer or a UNIX/Linux workstation:
The displayed list contains the Private Print jobs for which the same password has been set.
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Printing Private Print jobs
Follow the procedure below to process your Private Print jobs from the control panel.

1 On the Private Print job list (  P.135), select a job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.
If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 
[ALL CLEAR].

2 Press [PRINT].

The equipment starts printing.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (  P.128).
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Deleting Private Print jobs
Follow the procedure below to delete a Private Print job.

1 On the Private Print job list (  P.135), select the job that you want to delete, and then 
press [DELETE].

If the target job is not displayed on the screen, use  and  to change between pages.
If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 
[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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Hold Print jobs
Hold Print refers to the function to retain a document from a computer on the network until a user performs printing from 
the equipment’s touch panel. This function is useful to prevent you from forgetting to remove printed sheets. Hold Print 
jobs can be released or deleted from the Hold Print job list.
For the detailed instructions on Hold Print, see the following page:

 P.57 “Printing Hold Print jobs”

Displaying the Hold Print job list
Follow the procedure below to display the list of Hold Print jobs.

2 Press [HOLD].

The Hold Print jobs are listed on the screen.

1 On the control panel, press the [PRINT] button.
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3 On the Hold Print job list, select the desired user name.

The displayed list contains the Hold Print jobs stored in the Hold Print queue.

When you enter the nickname for [User name (Alias)] on a Windows computer, and send the job to the 
equipment, its nickname will be displayed on the Hold Print job list. If not, the user name that is entered to 
log in to your computer will be displayed on the Hold Print job list.
If you perform the operation as an administrator, press [ADMIN. PASSWORD] instead of selecting a user 
name. The on-screen keyboard appears, with which you can enter the 6-to-10-digit administrator password. 
In this case, the jobs can be deleted but are not allowed to be printed. If you enter an incorrect password 
three times in a row, the equipment becomes unavailable for operation (for about 30 seconds). In this case, 
wait until the equipment becomes available again, and then enter the correct administrator password.

When the Hold Print job is sent from a Windows computer:
- When the user name that is entered to log in to your computer is used for [User name (Alias)], the 

displayed list contains the Hold Print jobs which have been registered by the selected user.
- When the nickname is entered for [User name (Alias)], the displayed list contains all the Hold Print jobs 

which have been registered by users having the same nickname.
When the Hold Print job is sent from a Macintosh computer or a UNIX/Linux workstation:
- The displayed list contains the Hold Print jobs which have been registered by the selected user.
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Printing Hold Print jobs
Follow the procedure below to process your Hold Print jobs from the control panel.

1 On the Hold Print job list (  P.139), select a job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.
If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 
[ALL CLEAR].

2 Press [PRINT].

The equipment starts printing.
The job in progress can be monitored on the [JOBS] tab listing the Normal Print jobs (  P.128).

The printed job will be deleted from the Hold Print job list.
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Deleting Hold Print jobs
Follow the procedure below to delete a Hold Print job.

1 On the Hold Print job list (  P.139), select the job that you want to delete, and then 
press [DELETE].

If the target job is not displayed on the screen, use  and  to change between pages.
If you want to select all the jobs displayed on the screen, press [SELECT ALL]. To cancel the selection, press 
[ALL CLEAR].

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.
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Invalid jobs
An Invalid job refers to a job being held due to an incorrect or no department code entered for performing the job. If the 
equipment is managed by the Department Management feature with the SNMP network services enabled, entering an 
incorrect department code for printing from the touch panel causes the job to be held as an Invalid job and stored in the 
Invalid job queue. To release the job from the queue, enter the correct department code on the [JOBS] tab listing the 
Invalid jobs.

A print job whose number of copies to print exceeds the limit specified for a particular department code cannot be 
printed out. In this case, ask the administrator for help.

Displaying the Invalid job list
Follow the procedure below to display the list of Invalid jobs.

2 Press [INVALID].

The Invalid jobs are listed on the screen.

1 On the control panel, press the [PRINT] button.
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Printing Invalid jobs
If you have entered an incorrect department code for printing, you need to re-enter the correct one. Follow the procedure 
below.

1 On the Invalid job list (  P.143), select the job for printing.

If the target job is not displayed on the screen, use  and  to change between pages.

2 Press [PRINT].

3 Enter the correct department code with the digital keys, and then press [OK].

Printing starts.
The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs (  P.128).

The input department code appears as asterisks (*).
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Deleting Invalid jobs
Follow the procedure below to delete an Invalid job.

1 On the Invalid job list (  P.143), select the job that you want to delete, and then press 
[DELETE].

If the target job is not displayed on the screen, use  and  to change between pages.

2 When “Delete OK?” appears, press [DELETE].

The selected job is deleted.



5 MANAGING PRINT JOBS FROM THE CONTROL PANEL

146    Monitoring the Print Job Status

Printing files from USB media (USB Direct Printing)
USB Direct Printing refers to the printing of files saved in a USB storage device that is connected to the USB port on the 
equipment. With this feature, you can print PDF, encrypted PDF (file extension: “.pdf”), XPS (file extension: “.xps”), JPEG 
(file extension: “.jpg” or “.jpeg”), PRN (file extension: “.prn”), and PS (file extension: “.ps”) files.

USB Direct Printing requires the USB Direct Print setting to be enabled on TopAccess. For details, refer to the 
TopAccess Guide.
You cannot specify which page(s) of the selected file to print. All pages are to be printed.
USB Direct Printing supports the printing of PDF files whose versions are from 1.3 to 1.7.
With this feature, the equipment can print encrypted PDF files whose encryption level is either “40-bit RC4” or “128-
bit RC4.”
The feature does not support encrypted PDF files whose encryption level is [128bit AES], and some files of other 
encryption levels may not be printable as well. In these cases, print these files from a client computer.
For printing the PRN files, the page description languages supported by USB Direct Printing are PostScript (PS3), 
Printer Command Language (PCL5e and PCL6), and XML Paper Specification (XPS).
Do not turn on the equipment when a USB storage device is connected to the port.
The USB storage device should meet the following requirements:
- FAT16 and FAT32 formats
- Single-partition (USB media with multiple partitions are not supported.)

However, some of the devices may not be used in this equipment, even though these requirements have been met.
JPEG files in CMYK format cannot be printed.

1 Connect your USB storage device to the USB port on 
the equipment.
In a few seconds, “FOUND USB DEVICE” appears at the lower left 
corner of the screen.

Do not disconnect the USB storage device when “USB DEVICE in 
use Do not remove USB DEVICE” is displayed on the screen. 
Removing the device while the message is displayed could destroy 
the data in the device or cause a malfunction of the equipment.

2 On the control panel, press the [PRINT] button.
If the equipment is managed with department codes, proceed to 
step 3.
If the equipment is not managed with department codes, proceed to 
step 5.

3 If the equipment is managed with department codes, 
press the [ACCESS] button on the control panel.
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4 Enter the department code using the digital keys, and then press [OK].

The above screen will not be displayed when the equipment is not managed with department codes. In this 
case, proceed to the next step.
The input department code appears as asterisks (*).

5 Press [USB].

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is 
displayed on the screen. Removing the device while the message is displayed could destroy the data in the 
device or cause a malfunction of the equipment.
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6 In the list of files, select the file that you want to print, and then press [SETTINGS].

If the target file is not displayed on the screen, use  and  to change between pages.
To select a file contained in a folder, select the folder and press [OPEN]. In the list of files that appears, select 
the desired file to print.
If you do not need to change the number of copies to print or the paper size, you can press [PRINT] to start 
printing the selected file. If you have selected an encrypted PDF file for which a password has been set, 
proceed to step 9.

Do not disconnect the USB storage device when “USB DEVICE in use Do not remove USB DEVICE” is 
displayed on the screen. Removing the device while the message is displayed could destroy the data in the 
device or cause a malfunction of the equipment.

7 Specify the following items as required:
1) Using the digital keys, enter the number of copies to print.
2) Select the paper size.
3) Press [OK].

You can select the paper size only when printing a JPEG file. (When multiple JPEG files are to be printed in 
sequence, the paper size selected here is used.)
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8 Press [PRINT]. If you have selected an encrypted PDF file for which a password has 
been set, proceed to step 9.

The equipment starts printing. The printouts are directed to the receiving tray.
The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs.

Before Disconnecting the USB Storage Device:
Make sure that “USB DEVICE in use Do not remove USB DEVICE” is not displayed on the touch panel. If it is, do 
not disconnect the USB storage device; removing the device while the message is displayed could destroy the data 
in the device or cause a malfunction of the equipment.

9 Press [PASSWORD].

10 Using the on-screen keyboard and the digital keys, enter the user or master password 
for the encrypted PDF file, and then press [OK].

If the selected encrypted PDF file was created on Adobe Acrobat 6.0 or later, enter the document open 
password or permissions password.
To print an encrypted PDF file for which “Low Resolution (150 dpi)” is set on Adobe Acrobat, you must enter 
the permissions password that was set for the file when it was created.
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11 Press [OK].

The equipment starts printing. The printouts are directed to the receiving tray.
The job in progress can be monitored from the [JOBS] tab listing the Normal Print jobs.

Before Disconnecting the USB Storage Device:
Make sure that “USB DEVICE in use Do not remove USB DEVICE” is not displayed on the touch panel. If it is, do 
not disconnect the USB storage device; removing the device while the message is displayed could destroy the data 
in the device or cause a malfunction of the equipment.
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Viewing the Print Job Log

You can view the log of print jobs on the touch panel.

1 On the touch panel, press [JOB STATUS].

2 Press [LOG] to display the [LOG] tab.
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3 Press [PRINT].

The Print Log is displayed.

On the Print Log, each job’s user name, date and time of the job, paper size, the number of pages and the number 
of copies are displayed.

Up to 120 jobs can be listed on the log. To display the previous or next page, press  or . The number of jobs 
displayed on a page may vary depending on the equipment used.

To exit from the Print Log screen, press [RETURN].

If the equipment encounters an error while printing, it records and displays an error code in the User Name 
column. For details on print job errors and error codes, refer to the Troubleshooting Guide.
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FTP Printing

FTP printing is available when the FTP print service is enabled on this equipment.
You can print a document by sending the print file to this equipment using the FTP. This equipment can accept the 
following files for printing:

PCL file
PS file
Text file

When the User Management Setting is enabled on the equipment, the print jobs that are sent by FTP printing are 
processed as invalid jobs according to the Department Code Enforcement setting.

In Windows, you can create the PCL file and PS file using the printer driver. To create the PCL file or PS file, 
change the printer port of the printer driver to “FILE:” port and print a document using the printer driver. For more 
information about printing to a file, refer to the Windows documentation.
In Macintosh, you can create the PS file using the printer driver. To create the PS file, select “File” at the 
[Destination] box in the [Print] dialog box to print. For more information about printing to a file, refer to the 
Macintosh documentation.

Printing a file using the FTP command

The procedure below describes the example of printing using the FTP command with the MS-DOS Prompt.

1 Launch the MS-DOS Prompt.

2 Change the current directory to that in which the print file is located.

3 Type the following command and press the [Enter] key:
ftp <IP Address>

In the <IP Address> section, enter the IP address of this equipment.

4 If it prompts you to enter the user name, enter the FTP Print User Name and press the 
[Enter] key.

It prompts you to enter the user name if the FTP Print User Name is assigned by an administrator. Ask your 
administrator for the FTP Print User Name.

5 If it prompts you to enter the password, enter the FTP Print Password and press the 
[Enter] key.

It prompts you to enter the password if the FTP Print User Name is assigned by an administrator. Ask your 
administrator for the FTP Print Password.
If the FTP Print User Name has been assigned but the FTP Print Password is blank, do not enter anything 
when it prompts you to enter the password and press the [Enter] key.

6 Type the following command and press the [Enter] key:
put <file name>

For example, if the print file name is “sample.ps”:
put sample.ps

7 The file is sent to this equipment and spooled in the queue.
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Email Printing

Email printing is available when enabled on this equipment.
You can print a document by sending the print file, as an email attachment, to this equipment using the mail client 
software. This equipment can accept only TIFF-FX (Profile S), TIFF-FX (Profile F) and TIFF-FX (Profile J) files for printing.

When the User Management Setting is enabled on the equipment, the print jobs that are sent by Email printing are 
processed as invalid jobs according to the Department Code Enforcement setting.
The Email print job has two printing types, the Discard Printing and RX Reduction Printing, that can be set by 
pressing the [RX PRINT] button in the [FAX] of the ADMIN menu on the control panel.
When Discard Printing is ON, the part of the print image that exceeds the paper printing area is discarded if the 
print image is up to 10 mm larger than the printing area. If the print image is 10 mm or larger than the printing area, 
the print image is printed on the largest paper.
When Discard Printing is OFF, the print image is printed on the largest paper if its length exceeds the paper printing 
area.
When RX Reduction Printing is ON, it will be vertically reduced to fit on the paper if the print image is longer than 
the paper. When the print image cannot fit in the paper even if the print image is reduced, the print image is printed 
on the largest paper.
When RX Reduction Printing is OFF, the print image is printed on the largest paper if its length exceeds the paper 
printing area.

Printing a file using the email client

The procedure below gives an example of printing using the Microsoft Outlook Express.

When you send an email message to this equipment to print a file, send the message in plain text format. If you send 
an email message in the HTML format, this equipment prints the HTML source code of the message.

1 Open your email application and create a new mail message.

2 Enter the email address of the equipment in the To: line.

3 Enter text in the Subject line or leave the Subject line blank.

4 Enter text in the body field.

5 Attach the file you want to print.

6 Send the email.

The header and body of the email will be printed only when the “Print Header” and “Print Message Body” for the 
Email print service are enabled on this equipment.
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Internal Fonts List

Internal PCL fonts list

0 Courier 40 Helvetica-BoldOblique

1 CG-Times 41 Helvetica-Narrow

2 CG-Times Bold 42 Helvetica-Narrow-Bold

3 CG-Times Italic 43 Helvetica-Narrow-Oblique

4 CG-Times Bold Italic 44 Helvetica-Narrow-BoldOblique

5 CG Omega 45 Palatino-Roman

6 CG Omega Bold 46 Palatino-Bold

7 CG Omega Italic 47 Palatino-Italic

8 CG Omega Bold Italic 48 Palatino-BoldItalic

9 Coronet 49 ITC AvantGarde-Book

10 Clarendon Condensed 50 ITC AvantGarde-BookOblique

11 Univers Medium 51 ITC AvantGarde-Demi

12 Univers Bold 52 ITC AvantGarde-DemiOblique

13 Univers Italic 53 ITC Bookman-Light

14 Univers Bold Italic 54 ITC Bookman-LightItalic

15 Univers Medium Condensed 55 ITC Bookman-Demi

16 Univers Condensed Bold 56 ITC Bookman-DemiItalic

17 Univers Medium Condensed Italic 57 NewCenturySchlbk-Roman

18 Univers Condensed Bold Italic 58 NewCenturySchlbk-Bold

19 Antique Olive 59 NewCenturySchlbk-Italic

20 Antique Olive Bold 60 NewCenturySchlbk-BoldItalic

21 Antique Olive Italic 61 Times-Roman

22 Garamond Antiqua 62 Times-Bold

23 Garamond Halbfett 63 Times-Italic

24 Garamond Kursiv 64 Times-BoldItalic

25 Garamond Kursiv Halbfett 65 ITCZapfChancery-MediumItalic

26 Mrigold 66 Symbol

27 Albertus Medium 67 Symbol PS

28 Albertus Extra Bold 68 Wingdings

29 Arial 69 ITCZapfDingbats

30 Arial Bold 70 Courier Bold

31 Arial Italic 71 Courier Italic

32 Arial Bold Italic 72 Courier Bold Italic

33 Times New Roman 73 Letter Gothic Regular

34 Times New Roman Bold 74 Letter Gothic Bold

35 Times New Roman Italic 75 Letter Gothic Italic

36 Times New Roman Bold Italic 76 CourierPS

37 Helvetica 77 CourierPS Oblique

38 Helvetica-Bold 78 CourierPS Bold

39 Helvetica-Oblique 79 CourierPS BoldOblique
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AlbertusMT-Light Eurostile-ExtendedTwo

AlbertusMT Eurostile-BoldExtendedTwo

AlbertusMT-Italic Geneva

AntiqueOlive-Roman GillSans-Light

AntiqueOlive-Italic GillSans-LightItalic

AntiqueOlive-Bold GillSans

AntiqueOlive-Compact GillSans-Italic

Apple-Chancery GillSans-Bold

ArialMT GillSans-BoldItalic

Arial-ItalicMT GillSans-ExtraBold

Arial-BoldMT GillSans-BoldCondensed

Arial-BoldItalicMT GillSans-Condensed

AvantGarde-Book Goudy

AvantGarde-BookOblique Goudy-Italic

AvantGarde-Demi Goudy-Bold

AvantGarde-DemiOblique Goudy-BoldItalic

Bodoni Goudy-ExtraBold

Bodoni-Italic Helvetica

Bodoni-Bold Helvetica-Oblique

Bodoni-BoldItalic Helvetica-Bold

Bodoni-Poster Helvetica-BoldOblique

Bodoni-PosterCompressed Helvetica-Condensed

Bookman-Light Helvetica-Condensed-Oblique

Bookman-LightItalic Helvetica-Condensed-Bold

Bookman-Demi Helvetica-Condensed-BoldObl

Bookman-DemiItalic Helvetica-Narrow

Candid Helvetica-Narrow-Oblique

Chicago Helvetica-Narrow-Bold

Clarendon-Light Helvetica-Narrow-BoldOblique

Clarendon HoeflerText-Regular

Clarendon-Bold HoeflerText-Italic

CooperBlack HoeflerText-Black

CooperBlack-Italic HoeflerText-BlackItalic

Copperplate-ThirtyTwoBC HoeflerText-Ornaments

Copperplate-ThirtyThreeBC JoannaMT

Coronet-Regular JoannaMT-Italic

Courier JoannaMT-Bold

Courier-Oblique JoannaMT-BoldItalic

Courier-Bold LetterGothic

Courier-BoldOblique LetterGothic-Slanted

Eurostile LetterGothic-Bold

Eurostile-Bold LetterGothic-BoldSlanted

LubalinGraph-Book Univers-CondensedBold

LubalinGraph-BookOblique Univers-CondensedBoldOblique

LubalinGraph-Demi Univers-Extended

LubalinGraph-DemiOblique Univers-ExtendedObl

Marigold Univers-BoldExt

Monaco Univers-BoldExtObl

MonaLisa-Recut Wingdings-Regular

NewCenturySchlbk-Roman ZapfChancery-MediumItalic
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NewCenturySchlbk-Italic ZapfDingbats

NewCenturySchlbk-Bold

NewCenturySchlbk-BoldItalic

NewYork

Optima

Optima-Italic

Optima-Bold

Optima-BoldItalic

Oxford

Palatino-Roman

Palatino-Italic

Palatino-Bold

Palatino-BoldItalic

StempelGaramond-Roman

StempelGaramond-Italic

StempelGaramond-Bold

StempelGaramond-BoldItalic

Symbol

Taffy

Times-Roman

Times-Italic

Times-Bold

Times-BoldItalic

TimesNewRomanPSMT

TimesNewRomanPS-ItalicMT

TimesNewRomanPS-BoldMT

TimesNewRomanPS-BoldItalicMT

Univers-Light

Univers-LightOblique

Univers

Univers-Oblique

Univers-Bold

Univers-BoldOblique

Univers-Condensed

Univers-CondensedOblique
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